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License

Without producing harmful VOC (Volatile Organic Compounds), Samsung’s Eco-friendly “Crystal Design” 
expresses colour gradation thanks to our dual injection technology.

TruSurround HD, SRS and  symbol are trademarks of SRS Labs, Inc. TruSurround HD technology is 
incorporated under license from SRS Labs, Inc.

Manufactured under license from Dolby Laboratories. Dolby and the double-D symbol are trademarks of 
Dolby Laboratories.

DivX Certified products using Home Theatre Test Kit v3.0 or later: Plays DivX® video, including premium 
content.

Precautions When Displaying a Still Image 
A still image may cause permanent damage to the TV screen

Do not display still image and partially still on the LCD panel for more than 2 hours as it can cause screen image retention. 
This image retention is also known as screen burn. To avoid such image retention, reduce the degree of brightness and 
contrast of the screen when displaying a still image.

Watching the LCD TV in 4:3 format for a long period of time may leave traces of borders displayed on the 
left, right and centre of the screen caused by the difference of light emission on the screen. Playing a DVD or 
a game console may cause a similar effect to the screen. Damages caused by the above effect are not 
covered by the Warranty.

Displaying still images from Video games and PC for longer than a certain period of time may produce partial after-images. To 
prevent this effect, reduce the ‘brightness’ and ‘contrast’ when displaying still images.

© 2009 Samsung Electronics Co., Ltd. All rights reserved.
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SETTING UP YOUR TV

Figures and illustrations in this User Manual are provided for reference only and may differ from actual product appearance. 
Product design and specifications may be changed without notice in order to enhance product performance.

Viewing the Control Panel
The product colour and shape may vary depending on the model.
The front panel buttons can be activated by touching them with your finger.

1 SPEAKERS
2 REMOTE CONTROL SENSOR: Aim the remote control towards this spot on the TV.
3 SOURCE E: Toggles between all the available input sources. In the on-screen menu, use this button as you would use the 

ENTERE button on the remote control.
4 MENU: Press to see an on-screen menu of your TV’s features.
5 y: Press to increase or decrease the volume. 

In the on-screen menu, use the y buttons as you would use the ◄ and ► buttons on the remote control.
6 z: Press to change channels. In the on-screen menu, use the z buttons as you would use the ▼ and ▲ 

buttons on the remote control.
7 POWER INDICATOR: Blinks and turns off when the power is on and lights up in stand-by mode.
8 P (POWER): Press to turn the TV on and off.

N

¦
N
N

11

432 5 6 87
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Accessories

Remote Control & Batteries 
(AAA x 2) Power Cord Stand Screw X 4 Cover-Bottom

Program CD Cleaning Cloth Holder-Wire Cable
(Depending on the model)

Owner’s Instructions ● Warranty card● Safety Guide● Registration Cards●

Please make sure the following items are included with your LCD TV. If any items are missing, contact your dealer.
Warranty card / Safety Guide / Registration Cards (Not available in all locations)
The items colour and shape may vary depending on the model.

¦

N
N
N

(M4 X L16)
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Viewing the Connection Panel

The product colour and shape may vary depending on the model.
1 AV IN �, � [VIDEO] / [R-AUDIO-L]

Connect RCA cable to an appropriate external A/V device such as VCR, DVD or Camcorder.
Connect RCA audio cables to [R-AUDIO-L] on your set and the other ends to corresponding audio out connectors on the 
A/V device.

2 HDMI IN �, �, �(DVI), � / DVI AUDIO IN
Connects to the HDMI jack of a device with an HDMI output.

No additional Audio connection is needed for an HDMI to HDMI connection.
What is HDMI?
HDMI(High-Definition Multimedia Interface), is an interface that enables the transmission of digital audio and video signals 
using a single cable.
The difference between HDMI and DVI is that the HDMI device is smaller in size and has the HDCP (High Bandwidth 
Digital Copy Protection) coding feature installed.
The TV may not output sound and pictures may be displayed with abnormal colour when DVD / Blu-ray player / Cable 
Boxes / Satellite receivers supporting HDMI versions older than 1.3 are connected. When connecting an older HDMI 
cable and there is no sound, connect the HDMI cable to the HDMI IN �(DVI) jack and the audio cables to the DVI AUDIO 
IN jacks on the back of the TV. If this happens, contact the company that provided the DVD / Blu-ray player / Cable Box / 
Satellite receiver (Set-Top Box) to confirm the HDMI version, then request an upgrade.
Use the HDMI IN � (DVI) jack for DVI connection to an external device. Use a DVI to HDMI cable or DVI-HDMI adapter 
(DVI to HDMI) for video connection and the DVI AUDIO IN jacks for audio. When using an HDMI / DVI cable connection, 
you must use the HDMI IN � (DVI) jack.
HDMI cables that are not 1.3 may cause annoying flicker or no screen display.

3 PC IN [PC] / [AUDIO]
Connect to the video and audio output jack on your PC.
If your PC supports an HDMI connection, you can connect this to the HDMI IN �, �, �(DVI) or � terminal.
If your PC supports a DVI connection, you can connect this to the HDMI IN � (DVI) / DVI AUDIO IN terminal.

4 ANT IN
Connects to an antenna or cable TV system.

¦

N

–
–

N
N
●

●

N

N

N

–
N
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[TV Side Panel]

[TV Rear Panel]

Power Input
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5 LAN
Connect a LAN cable to this port to connect to the Network. 

6 KENSINGTON LOCK (depending on the model)
The Kensington Lock (optional) is a device used to physically fix the system when used in a public place. If you want to use a 
locking device, contact the dealer where you purchased the TV.

The location of the Kensington Lock may be different depending on its model.
7 H (HEADPHONE)

Headphone may be connected to the headphone output on your set. While the head phone is connected, the sound from 
the built-in speakers will be disabled.
Using the sound function is restricted when connecting headphones to the TV.
Prolonged use of headphones at a high volume may damage your hearing.
You will not hear sound from the speakers when you connect headphones to the TV.
The headphone volume and TV volume are adjusted separately.

8 AUDIO OUT [R-AUDIO-L]
Connect RCA audio cables to AUDIO OUT [R-AUDIO-L] on the rear of your set and the other ends to corresponding 
audio in connectors on the Amplifier or DVD Home Theatre.

9 SERVICE 
Connector for service only.

0 COMPONENT IN �, �
Connect component video cables (optional) to component connector (PR, PB, Y) on the rear of your set and the other ends 
to corresponding component video out connectors on the DVD.
If you wish to connect both the Set-Top Box and DVD, you should connect the Set-Top Box to the DVD and connect the 
DVD to component connector (PR, PB, Y) on your set.
The PR, PB and Y connectors on your component devices DVD are sometimes labeled Y, B-Y and R-Y or Y, Cb and Cr.
Connect RCA audio cables (optional) to [R-AUDIO-L] on the rear of your set and the other ends to corresponding audio 
out connectors on the DVD.

! USB�(HDD) / USB�
Connector for software upgrades and Media Play, etc.
You can connect to Samsung’s network wirelessly using the ‘Samsung Wireless LAN Adapter’ (Sold separately).
For USB HDD, use the USB�(HDD) port.

–

N

–

N
N
N
N

–

–

–

–

–
–

–
–
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Viewing the Remote Control
You can use the remote control up to a distance of about 23 feet from the TV.
The performance of the remote control may be affected by bright light.
The product colour and shape may vary depending on the model.

1 POWER : Turns the TV on and 
off.

2 TV : Selects the TV mode 
directly.

3 NUMERIC BUTTONS : Press to 
change the channel.

4 E : Performs the same function 
as the ENTERE button of 
the directional buttons. When 
switching channels with the 
numeric buttons, and you press 
the channel number and then the 
ENTERE button, the channel is 
immediately switched.

5 CH LIST : Displays the Channel 
List on screen.

6 TOOLS : Use to quickly select 
frequently used functions.

7 INTERNET@ : Press to use 
various internet services to 
view useful information and 
entertaining content.

8 COLOUR BUTTONS : Use these 
buttons in the Channel list, 
Internet@TV, Media Play menu, 
etc.

9 SOURCE : Press to display 
and select the available video 
sources.

0 Y : Press to increase or 
decrease the volume.

! MUTE M : Press to temporarily 
cut off the sound. 

# INFO : Press to display 
information on the TV screen.

$ Use these buttons in the DMA, 
Media Play and Anynet+ modes. 
(∏: This remote can be used 
to control recording on Samsung 
recorders with the Anynet+ 
feature)

% ON/OFF @ : Pressing the 
ON/OFF @ light button toggles 
between on and off. When the 
remote control is on, and a button 
is pressed on the remote control, 
the remote control buttons will 
be lit for a moment. (Using the 
remote control with the ON/OFF 
@ light button set to On will 
reduce the battery usage time.)

^ PRE-CH : Enables you to return 
to the previous channel you were 
watching.

& MENU : Displays the main on-
screen menu.

* FAV.CH : Used to display 
Favourites channel Lists on the 
screen.

( RETURN : Returns to the 
previous menu

)	 UP▲	/	DOWN▼	/	LEFT◄	/	
RIGHT►	/	ENTERE : Use to 
select on-screen menu items and 
change menu values.

a EXIT : Press to exit the menu.
b > P < : Press to change 

channels.
c MEDIA.P : Allows you to play 

music files, pictures, and movies.
d CONTENT : This function 

enables you to view the Content 
Library.

e DUAL : Sound effect selection
f P.SIZE : Picture size selection

Teletext Functions
2 : : Exit from the Teletext 

display
5 8 : Teletext store
6 4 : Teletext size selection
8 Fastext topic selection
9 0 : Teletext mode selection 

(LIST / FLOF)
@ / : Alternately select 

Teletext, Double, or Mix.
# 5 : Teletext reveal
^ 1 : Teletext sub page
& 6 : Teletext index
( 9 : Teletext hold
a 7 : Teletext cancel
b 2 : Teletext next page

3 : Teletext previous page

¦
N
N
N

1
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^
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Installing Batteries in the Remote Control

�. Lift the cover at the back of the remote control upward as shown in the figure.
�. Install two AAA size batteries. 

Make sure to match the ‘+’ and ‘–’ ends of the batteries with the diagram inside the 
compartment.

�. Replace the cover.
Remove the batteries and store them in a cool, dry place if you won’t be using the 
remote control for a long time. 

If the remote control doesn’t work, check the following:
Is the TV power on? 
Are the plus and minus ends of the batteries reversed?
Are the batteries drained?
Is there a power outage or is the power cord unplugged?
Is there a special fluorescent light or neon sign nearby?OPERATION

OPERATION

Viewing the menus
Before using the TV, follow the steps below to learn how to navigate the menu in order to select and adjust different functions.

Operation the OSD (On Screen Display)
The access step may differ depending on the selected menu.
�. Press the MENU button.

�. The main menu appears on the screen. The menu’s left side has icons : Picture, Sound, 
Channel, Setup, Input, Application, Support.

�. Press the ▲ or ▼ button to select one of the icons.

�. Then press the ENTERE button to access the icon’s sub-menu.
�. Press the ▲ or ▼ button to select the icon’s submenu.

�. Press the ◄ or ► button to decrease or increase the value of a particular item. The 
adjustment OSD may differ depending on the selected menu.

�. Press the ENTERE button to complete the configuration. Press the EXIT button to exit.

¦

N

N

N
•
•
•
•
•

¦

❑

MENU Button
Display the main on-screen menu.

ENTERE / DIRECTION Buttons
Move the cursor and select an 

item. Select the currently selected 
item. Confirm the setting.

RETURN Button
Return to the previous menu.

EXIT
Exit the on-screen menu.

Mode	 :	Standard	 ▶

Backlight	 :	7
Contrast	 :	95
Brightness	 :	45
Sharpness	 :	50
Colour	 :	50
Tint	(G/R)	 :	G50/R50
Advanced	Settings

Picture

Mode	 :	Standard

Backlight	 :	7	 ▶

Contrast	 :	95
Brightness	 :	45
Sharpness	 :	50
Colour	 :	50
Tint	(G/R)	 :	G50/R50
Advanced	Settings
Picture	Options

Picture

7

 U	Move				L	Adjust					E	Enter					R	Return

						▲
Backlight
						▼

Help icon
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Placing Your Television in Standby Mode
Your set can be placed in standby mode in order to reduce the power consumption. The standby mode can be useful when you
wish to interrupt viewing temporarily (during a meal, for example).
�. Press the POWERP button on the remote control.

The screen is turned off and a red standby indicator appears on your set.
�. To switch your set back on, simply press the POWERP button again.

Do not leave your set in standby mode for long periods of time (when you are away on holiday, for example). It is best to 
unplug the set from the mains and aerial.

Plug & Play Feature
When the TV is initially powered on, basic settings proceed automatically and subsequently.
�. Press the POWERP button on the remote control. 

You can also use the POWERP button on the TV.
The message Select the OSD Language. is displayed.

�. Press the ENTERE button. Press the ▲ or ▼ button to select the language, then press 
the ENTERE button. The message Select ‘Home Use’ when installing this TV in your 
home. is displayed.

�. Press the ◄ or ► button to select Store Demo or Home Use, then the ENTERE button.
We recommend setting the TV to Home Use mode for the best picture in your home 
environment.
Store Demo mode is only intended for use in retail environments.
If the unit is accidentally set to Store Demo mode and you want to return to Home Use (Standard): Press the volume 
button on the TV. When the volume OSD is displayed, press and hold the MENU button on the TV for 5 seconds.

�. Press the ENTERE button. Select the appropriate area by pressing the ▲ or ▼ button. Press the ENTERE button to 
confirm your choice.

�. The channel search will start and end automatically.
Press the ENTERE button at any time to interrupt the memorization process.
After all the available channels are stored, the message Set current date and time is displayed.

�. Press the ENTERE button.
Select the Day, Month, Year, Hour or Minute by pressing the ◄ or ► button.
Set the Day, Month, Year, Hour or Minute by pressing the ▲ or ▼ button.

You can also set the Day, Month, Year, Hour and Minute by pressing the number buttons on the remote control.
�. The connection method to provide the best quality HD is offered. After confirming the method, press the ENTERE button.
�. Press the ◄ or ► button to select See Product Guide or Watch TV, then the ENTERE button.

See Product Guide: You are moved to the Product Guide where you can view the introduction to the main functions of 
your new HDTV.
Watch TV: You can watch the memorized channels.

If you want to reset this feature...
�. Press the MENU button to display the menu. Press the ▲ or ▼ button to select Setup, 

then press the ENTERE button.
�. Press the ENTERE button again to select Plug & Play.
�. Enter your 4 digit PIN number. The default PIN number of a new TV set is ‘0-0-0-0’.

If you want to change PIN number, use the Change PIN function. (refer to page 19)
The Plug & Play feature is only available in the TV mode.

¦

N

N

¦

N
N

N

N
N

N
N

N

•

•

N
N

Plug	&	Play	 	 ▶

Language	 :	English
Time
Game	Mode	 :	Off
BD	Wise	 :	Off
Network	Type	 :	Cable
Network	Setup
Child	Lock	 :	On

Setup

Select	the	OSD	Language.

Language	 :	English	 �

Plug	&	Play

E	Enter
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CHANNEL

Channel Menu

Area
You can change the area for channels.

Auto Store
You can scan for the frequency ranges available to you (and availability depends on your 
area). Automatically allocated programme numbers may not correspond to actual or desired 
programme numbers.

If a channel is locked using the Child Lock function, the PIN input window appears.
Scans for all channels with active broadcast stations and stores them in the TV’s memory.
If you want to stop Auto Store, press the ENTERE button.
The Stop Auto Store? message will be displayed.
Select Yes by pressing the ◄ or ► button, then press the ENTERE button.

Manual Store
Scans for a channel manually and stores it in the TV’s memory.
If a channel is locked using the Child Lock function, the PIN input window appears.
Programme (Programme number to be assigned to a channel): Sets the programme number using the ▲, ▼ or number (0~9) 
buttons.
Colour	System	→	Auto	/	PAL	/	SECAM	/	NTSC4.43	/	NTSC	3.58: Sets the colour system value using the ▲ or ▼ button.
Sound	System	→	BG	/	DK	/	I	/	M: Sets the sound system value using the ▲ or ▼ button.
Channel (When you know the number of the channel to be stored): Press the ▲ or ▼ button to select C (Air channel) or S 
(Cable channel). Press the ► button, then press the ▲, ▼ or number (0~9) buttons to select the required number.

You can also select the channel number directly by pressing the number (0~9) buttons.
If there is abnormal sound or no sound, reselect the sound standard required.

Search (When you do not know the channel numbers): Press the ▲ or ▼ button to start the search. The tuner scans the 
frequency range until the first channel or the channel that you selected is received on the screen.
Store (When you store the channel and associated programme number): Set to OK by pressing the ENTERE button.

Channel mode
P (Programme mode): When completing tuning, the broadcasting stations in your area have been assigned to position 
numbers from P00 to P99. You can select a channel by entering the position number in this mode.
C (Air channel mode): You can select a channel by entering the assigned number to each air broadcasting station in this 
mode.
S (Cable channel mode): You can select a channel by entering the assigned number for each cable channel in this mode.

Channel List
For detailed procedures on using the Channel List, refer to the ‘Managing Channels’ instructions. (refer to page 10)

You can select these options by simply pressing the CH LIST button on the remote control.

Channel Mode
When press the P >/< button, Channels will be switched within the selected channel list.

Added Ch.
Channels will be switched within the memorized channel list.

Favourite Ch.
Channels will be switched within the favourite channel list.

Fine Tune
If the reception is clear, you do not have to fine tune the channel, as this is done automatically during the search and store 
operation. If the signal is weak or distorted, you may have to fine tune the channel manually.

Fine tuned channels that have been saved are marked with an asterisk “*” on the right-hand side of the channel number in the 
channel banner.
To reset the fine-tuning, select Reset by pressing the ▲ or ▼ button and then press the ENTERE button.
Only TV channels can be fine tuned.

¦
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❑
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Area	 :	Asia/Europe	 ▶

Auto	Store
Manual	Store
Channel	List
Channel	Mode	 :	Added	ch.
Fine	Tune

Channel
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Managing Channels 
Using this menu, you can add / delete or set favourites channels.

All Channels
Shows all currently available channels.

Added Channels
Shows all added channels.

Favourites
Shows all favourite channels.

To select the favourites channels you have set up, press the FAV.CH button on the remote control.

Programmed
Shows all current reserved programmes.

Select a channel in the All Channels, Added Channels or Favourites screen by pressing the ▲ / ▼ buttons, and pressing 
the ENTERE button. Then you can watch the selected channel.
Using the Colour buttons with the Channel List

Green (Zoom): Enlarges or shrinks a channel number.
Yellow (Select): Selects multiple channel lists.

You can perform the add/delete or add to favourites/delete from favourites function for multiple channels at the same 
time.
Select the required channels and press the Yellow button to set all the selected channels at the same time. 
The c mark appears to the left of the selected channels.

TOOLS (Tools): Displays the Delete (or Add), Add to Favourite (or Delete from Favourite), Lock (or Unlock), Timer 
Viewing, Edit Channel Name, Sort, Select All (or Deselect All), Auto Store menu. (The Options menus may differ 
depending on the situation.)

Channel Status Display Icons

c A channel selected by pressing the yellow button. * A channel set as a Favourite.

( A programme currently being broadcast. \ A locked channel.

) A reserved programme

Channel List Option Menu (in All Channels / Added Channels / Favourites)
Press the TOOLS button to use the option menu.
Option menu items may differ depending on the channel status.

Add / Delete
You can delete or add a channel to display the channels you want.

All deleted channels will be shown on All Channels menu.
A gray-coloured channel indicates the channel has been deleted.
The Add menu only appears for deleted channels.
You can also delete a channel to the Added Channels or Favourites menu in the same 
manner.

Add to Favourite / Delete from Favourite
You can set channels you watch frequently as favourites.

Press the TOOLS button to display the Tools menu. You can also set the add to (or delete from) Favourite by selecting Tools 
→	Add	to	Favourite (or Delete from Favourite).
The * symbol will be displayed and the channel will be set as a favourite.
All favourite channels will be shown on Favourites menu.

Lock / Unlock
You can lock a channel so that the channel cannot be selected and viewed. 

This function is available only when the Child Lock is set to On. (see page 19)
The PIN number input screen appears. Enter your 4 digit PIN number.
The default PIN number of a new TV set is “0-0-0-0”. You can change the PIN, by selecting Change PIN from the menu.
The \ symbol will be displayed and the channel will be locked.
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Added	Channels

1	 C	--
2	 C	--

3																					C	--

4	 C	--
5					*	 C	--
6	 C	--
7	 C	--
8	 C	--
9	 C	--
10	 C	--

					 	Zoom			 	Select			T	Tools

All	Channels

1	 C	--
2	 C	--

3																					C	--

4	 C	--
5					*	 C	--
6	 C	--
7	 C	--
8	 C	--
9	 C	--
10	 C	--

				 	Zoom			 	Select			T	Tools

Delete
Add	to	Favourite
Lock
Timer	Viewing
Edit	Channel	Name
Sort
																																							�
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Timer Viewing
If you reserve a programme you want to watch, the channel is automatically switched to the reserved channel in the Channel List; 
even when you are watching another channel. To reserve a programme, set the current time first. (see page 20)

Only memorized channels can be reserved.
You can set the channel, day, month, year, hour and minute directly by pressing the number buttons on the remote control.
Reserving a programme will be shown in the Programmed menu.

Edit Channel Name
Channels can labelled so that their call letters appear whenever the channel is selected.

Sort
This operation allows you to change the programme numbers of the stored channels. This operation may be necessary after using 
the auto store.

Select All / Deselect All
Select All: You can select all the channels in the channel list.
Deselect All: You can deselect all the selected channels.
You can only select Deselect All when there is a selected channel.

Auto Store
For detailed procedures on setting up options, refer to page 9.
If a channel is locked using the Child Lock function, the PIN input window appears.

Channel List Option Menu (in Programmed)
You can view, modify or delete a reservation.

Press the TOOLS button to use the option menu.

Change Info
Select to change a viewing reservation.

Cancel Schedules
Select to cancel a viewing reservation.

Information
Select to view a viewing reservation. 
(You can also change the reservation information.)

Select All
Select all reserved programmes.
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Programmed

1	/	1	/	2009

13:59				5												)	

2	/	1	/	2009
18:59						2															)	The	Equalizer
20:59						2															)	McMillan	&	Wife
21:59						2															)	M.Spillane’s	mike	

						'	Zoom			'	Select			T	Tools			E	Information

Change	Info
Cancel	Schedules
Information
Select	All
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PICTURE

Configuring the Picture Menu

Mode
You can select the type of picture which best corresponds to your viewing requirements.

Press the TOOLS button to display the Tools menu. You can also set the picture mode by 
selecting Tools	→	Picture	Mode.

Dynamic
Selects the picture for increased definition in a bright room.

Standard
Selects the picture for the optimum display in a normal environment.

Natural
Selects the picture for an optimum and eye-comfortable display.

This function is not available in PC mode.

Movie
Selects the picture for viewing movies in a dark room.

Backlight / Contrast / Brightness / Sharpness / Colour / Tint (G/R)
Your television has several setting options that allow you to control the picture quality.

Backlight
Adjusts the brightness of LCD back light.

Contrast
Adjusts the contrast level of the picture.

Brightness
Adjusts the brightness level of the picture

Sharpness
Adjusts the edge definition of the picture.

Colour
Adjusts colour saturation of the picture.

Tint (G/R)
Adjusts the colour tint of the picture.

In TV, AV�, AV� modes of the PAL system, you cannot use the Tint (G/R) Function.
When you make changes to Backlight, Contrast, Brightness, Sharpness, Colour or Tint (G/R), the OSD will be adjusted 
accordingly.
In PC mode, you can only make changes to Backlight, Contrast and Brightness.
Settings can be adjusted and stored for each external device you have connected to an input of the TV.
The energy consumed during use can be significantly reduced if the brightness level of the picture is lowered, which will 
reduce the overall running cost.
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 U	Move				L	Adjust					E	Enter					R	Return

						▲
Backlight
						▼

Mode	 :	Standard	 ▶

Backlight	 :	7
Contrast	 :	95
Brightness	 :	45
Sharpness	 :	50
Colour	 :	50
Tint	(G/R)	 :	G50/R50
Advanced	Settings

Picture
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Advanced Settings
Samsung’s new TVs allow you to make even more precise picture settings than previous 
models.

Advanced Settings is available in Standard or Movie mode.
In PC mode, you can only make changes to Dynamic Contrast, Gamma and White 
Balance from among the Advanced Settings items.

Black	Tone	→	Off	/	Dark	/	Darker	/	Darkest
You can select the black level on the screen to adjust the screen depth.

Dynamic	Contrast	→	Off	/	Low	/	Medium	/	High
You can adjust the screen contrast so that the optimal contrast is provided.

Gamma
You can adjust the primary colour (red, green, blue) Intensity.

Colour Space
Colour Space is a colour matrix composed of red, green and blue colours. Select your favourite colour space to experience the 
most natural colour.

Auto: Auto Colour Space automatically adjusts to the most natural colour tone based on programme sources.
Native: Native Colour Space offers deep and rich colour tone.
Custom: Adjusts the colour range to suit your preference.

Changing the adjustment value will refresh the adjusted screen.
Settings can be adjusted and stored for each external device you have connected to an input of the TV. For example, if 
you have a DVD player connected to HDMI 1 and it is currently selected, settings and adjustments will be saved for the 
DVD player. 

Colour: Red, Green, Blue, Yellow, Cyan or Magenta
Colour is available when Colour Space is set to Custom.
In Colour, you can adjust the RGB values for the selected colour.
To reset the adjusted RGB value, select Reset.

Red: Adjusts the red saturation level of the selected colour.
Green: Adjusts the green saturation level of the selected colour.
Blue: Adjusts the blue saturation level of the selected colour.
Reset: Resets the colour space to the default values.

White Balance
You can adjust the colour temperature for more natural picture colours.

R-Offset: Adjusts the red colour darkness.
G-Offset: Adjusts the green colour darkness.
B-Offset: Adjusts the blue colour darkness.
R-Gain: Adjusts the red colour brightness.
G-Gain: Adjusts the green colour brightness.
B-Gain: Adjusts the blue colour brightness.
Reset: The previously adjusted white balance will be reset to the factory defaults.

Flesh Tone
You can emphasize the pink ‘flesh tone’ in the picture.

Changing the adjustment value will refresh the adjusted screen.

Edge	Enhancement	→	Off	/	On
You can emphasize object boundaries in the picture.

xvYCC	→	Off	/	On
Setting the xvYCC mode to on increases detail and colour space when watching movies from an external device (ie. DVD player) 
connected to the HDMI or Component IN jacks.

xvYCC is available when the picture mode is set to Movie, and the external input is set to HDMI or Component mode.
This function may not be supported depending on your external device.
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Black	Tone	 :	Off	 	 ▶
Dynamic	Contrast	 :	Medium
Gamma	 :	0
Colour	Space	 :	Native
White	Balance
Flesh	Tone	 :	0
Edge	Enhancement	 :	On

U	Move					E	Enter					R	Return

Advanced	Settings
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Picture Options
In PC mode, you can only make changes to the Colour Tone and Size from among the 
items in Picture Options.

Colour	Tone	→	Cool	/	Normal	/	Warm1	/	Warm2	/	Warm3
Warm�, Warm� or Warm� is only activated when the picture mode is Movie.
Settings can be adjusted and stored for each external device you have connected to an 
input of the TV.

Size
Occasionally, you may want to change the size of the image on your screen. Your TV comes with several screen size options, each 
designed to work best with specific types of video input. Your cable box/satellite receiver may have its own set of screen sizes as 
well. In general, though, you should view the TV in 16:9 mode as much as possible.

Alternately, you can press the P.SIZE button on the remote control repeatedly to change the picture size.
��:�: Adjusts the picture size to 16:9 appropriate for DVDs or wide broadcasting.
Wide Zoom: Magnify the size of the picture more than 4:3.
Zoom: Magnifies the 16:9 wide picture (in the vertical direction) to fit the screen size.
�:�: This is the default setting for a video movie or normal broadcasting.
Screen Fit: Use the function to see the full image without any cut-off when HDMI (720p / 1080i / 1080p) or Component (1080i 
/ 1080p) signals are input.

Depending on the input source, the picture size options may vary.
The items available may differ depending on the selected mode.
In PC Mode, only ��:� and �:� mode can be adjusted.
Settings can be adjusted and stored for each external device you have connected to an input of the TV.
Temporary image retention may occur when viewing a static image on the set for more than two hours.
Wide Zoom: Press the ► button to Select Position, then press the ENTERE button. Press the ▲ or ▼ button to move 
the picture up / down. Then press the ENTERE button.
Zoom: Press the ► button to Select Position, then press the ENTERE button. Press the ▲ or ▼ button to move the 
picture up and down. Then press the ENTERE button. Press the ► button to Select Size, then press the ENTERE 
button. Press the ▲ or ▼ button to magnify or reduce the picture size in the vertical direction. Then press the ENTERE 
button.
After selecting Screen Fit in HDMI (1080i / 1080p) or Component (1080i / 1080p) mode: Select Position by pressing the 
◄ or ► button. Use the ▲, ▼, ◄ or ► button to move the picture.

Reset: Press the ◄ or ► button to select Reset, then press the ENTERE button. You can initialize the setting.
If you use the Screen Fit function with HDMI 720p input, 1 line will be cut at the top, bottom, left and right as in the 
overscan function.
When Double (À, Œ) mode has been set in PIP, the Picture Size cannot be set.

Digital	NR	→	Off	/	Low	/	Medium	/	High	/	Auto
If the broadcast signal received by your TV is weak, you can activate the Digital Noise Reduction feature to help reduce any static 
and ghosting that may appear on the screen.

When the signal is weak, select one of the other options until the best picture is displayed.

HDMI	Black	Level	→	Normal	/	Low
You can directly select the black level on the screen to adjust the screen depth.

This function is active only when the external input connects to HDMI (RGB signals).

Film	Mode	→	Off	/	Auto1	/	Auto2
The TV can be set to automatically sense and process film signals from all sources and adjust the picture for optimum quality.

Film Mode is supported in TV, AV, COMPONENT(480i / 1080i) and HDMI(480i / 1080i).
Off: Turn the Film Mode function off.
Auto�: Automatically adjusts the picture for the best quality when watching a film.
Auto�: Automatically optimizes the video text on the screen (not including closed captions) when watching a film.
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Colour	Tone	 :	Normal	 	 ▶
Size	 :	16:9
Digital	NR	 :	Auto
HDMI	Black	Level	 :	Normal
Film	Mode	 :	Off
240Hz	Motion	Plus	 :	Standard
Blue	Only	Mode	 :	Off

U	Move					E	Enter					R	Return

Picture	Options
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240Hz	Motion	Plus	→	Off	/	Clear	/	Standard	/	Smooth	/	Custom	/	Demo
Removes drag from fast scenes with a lot of movement to provide a clearer picture.

If you enable ��0Hz Motion Plus, noise may appear on the screen. If this occurs, set ��0Hz Motion Plus to Off.
Off: Switches 240Hz Motion Plus off.
Clear: Sets 240Hz Motion Plus to minimum.
Standard: Sets 240Hz Motion Plus to medium.
Smooth: Sets 240Hz Motion Plus to maximum.
Custom: Adjusts the blur and judder reduction level to suit your preference.

Blur Reduction: Adjusts the blur reduction level from video sources.
Judder Reduction: Adjusts the judder reduction level from video sources when playing films.
Reset: Reset the custom settings.

Demo: Displays the difference between 240Hz Motion Plus on and off modes.

Blue	Only	Mode	→	Off	/	On
This function is for AV device measurement experts. This function displays the blue signal only by removing the red and green 
signals from the video signal so as to provide a Blue Filter effect that is used to adjust the Colour and Tint of video equipment such 
as DVD players, Home Theatres, etc. Using this function, you can adjust the Colour and Tint to preferred values appropriate to 
the signal level of each video device using the Red / Green / Blue / Cyan / Magenta / Yellow Colour Bar Patterns, without using an 
additional Blue Filter.

Blue Only Mode is available when the picture mode is set to Movie or Standard.

Picture	Reset	→	Reset	Picture	Mode	/	Cancel
Resets all picture settings to the default values.

Reset Picture Mode: Current picture values return to default settings.

Viewing Picture-in-Picture
You can use the PIP feature to simultaneously watch the TV tuner and one external video 
source. This product has one built-in tuner, which does not allow PIP to function in the same 
mode. Please see ‘PIP Settings’ below for details.

Press the TOOLS button to display the Tools menu. You can also configure PIP related 
settings by selecting Tools	→	PIP.
If you select the PIP picture sound, refer to the ‘Configuring the Sound Menu’ instructions. 
(refer to pages 17~18)
PIP Settings
Main picture Sub picture
Component�, �
HDMI�, HDMI�, HDMI�/DVI, HDMI�
PC

TV, AV�, AV�

If you turn the TV off while watching in PIP mode and turn it on again, the PIP window will disappear.
You may notice that the picture in the PIP window becomes slightly unnatural when you use the main screen to view a game 
or karaoke.
While Internet@TV is in operation, the PIP function cannot be used.

PIP	→	Off	/	On
You can activate or deactivate the PIP function. 

Source
You can select a source of the sub-picture.

Size	→	Õ / Ã / À / Œ
You can select a size of the sub-picture.

Position	→	Ã / – / — / œ
You can select a position of the sub-picture.

In Double (Œ, À) mode, Position cannot be selected.

Channel
You can select the channel for the sub-screen.

Channel is available when the Source is set to TV.
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Melody	 :	Medium
Energy	Saving	 :	Off

PIP	 	 ▶

Setup

PIP	 :	On	 	 ▶
Source	 :	TV
	Size	 :	Õ
Position	 :	Ã
Channel	 :	ATV	4

U	Move					E	Enter					R	Return

PIP
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Using Your TV as a Computer (PC) Display

Setting Up Your PC Software (Based on Windows XP)
The Windows display-settings for a typical computer are shown below. The actual screens on 
your PC will probably be different, depending upon your particular version of Windows and 
your particular video card. However, even if your actual screens look different, the same basic 
set-up information will apply in almost all cases. (If not, contact your computer manufacturer or 
Samsung Dealer.)
�. First, click on ‘Control Panel’ on the Windows start menu.
�. When the control panel window appears, click on ‘Appearance and Themes’ and a display 

dialog-box will appear.
�. When the control panel window appears, click on ‘Display’ and a display dialogbox will 

appear.
�. Navigate to the ‘Settings’ tab on the display dialog-box.

The correct size setting (resolution) - Optimum: 1920 X 1080 pixels
If a vertical-frequency option exists on your display settings dialog box, the correct 
value is ‘60’ or ‘60 Hz’. Otherwise, just click ‘OK’ and exit the dialog box.

Display Modes
If the signal from the system equals the standard signal mode, the screen is adjusted automatically. If the signal from the system 
doesn’t equal the standard signal mode, adjust the mode by referring to your videocard user guide; otherwise there may be no 
video. For the display modes listed on the next page, the screen image has been optimized during manufacturing.

D-Sub and HDMI/DVI Input

Mode Resolution Horizontal Frequency 
(KHz)

Vertical Frequency 
(Hz)

Pixel Clock Frequency 
(MHz)

Sync Polarity 
(H / V)

IBM 640 x 350 31.469 70.086 25.175 +/-
720 x 400 31.469 70.087 28.322 -/+

MAC
640 x 480 35.000 66.667 30.240 -/-
832 x 624 49.726 74.551 57.284 -/-
1152 x 870 68.681 75.062 100.000 -/-

VESA CVT

720 x 576 35.910 59.950 32.750 -/+
1152 x 864 53.783 59.959 81.750 -/+
1280 x 720 44.772 59.855 74.500 -/+
1280 x 720 56.456 74.777 95.750 -/+
1280 x 960 75.231 74.857 130.000 -/+

VESA DMT

640 x 480 31.469 59.940 25.175 -/-
640 x 480 37.861 72.809 31.500 -/-
640 x 480 37.500 75.000 31.500 -/-
800 x 600 37.879 60.317 40.000 +/+
800 x 600 48.077 72.188 50.000 +/+
800 x 600 46.875 75.000 49.500 +/+

1024 x 768 48.363 60.004 65.000 -/-
1024 x 768 56.476 70.069 75.000 -/-
1024 x 768 60.023 75.029 78.750 +/+
1152 x 864 67.500 75.000 108.000 +/+

1280 x 1024 63.981 60.020 108.000 +/+
1280 x 1024 79.976 75.025 135.000 +/+
1280 x 800 49.702 59.810 83.500 -/+ 
1280 x 800 62.795 74.934 106.500 -/+ 
1280 x 960 60.000 60.000 108.000 +/+
1360 x 768 47.712 60.015 85.500 +/+
1440 x 900 55.935 59.887 106.500 -/+ 
1440 x 900 70.635 74.984 136.750 -/+

1680 x 1050 65.290 59.954 146.250 -/+ 
VESA GTF 1280 x 720 52.500 70.000 89.040 -/+ 

1280 x 1024 74.620 70.000 128.943 -/-
VESA DMT / 

DTV CEA 1920 x 1080p 67.500 60.000 148.500 +/+

When using an HDMI / DVI cable connection, you must use the HDMI IN �(DVI) jack.
The interlace mode is not supported.
The set might operate abnormally if a non-standard video format is selected.
Separate and Composite modes are supported. SOG is not supported.
Too long or low quality VGA cable can cause picture noise at high resolution modes (1920x1080).
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Setting up the TV with your PC
Preset: Press the SOURCE button to select PC mode.

Auto Adjustment
Use the Auto Adjust function to have the TV set automatically adjust the video signals it 
receives.
The function also automatically fine-tunes the settings and adjusts the frequency values and 
positions.

Press the TOOLS button to display the Tools menu. You can also set the Auto Adjustment 
by selecting Tools	→	Auto	Adjustment.
This function does not work in DVI-HDMI mode.

Screen

Coarse / Fine
The purpose of picture quality adjustment is to remove or reduce picture noise. If the noise is 
not removed by Fine-tuning alone, then adjust the frequency as best as possible (Coarse) and 
Fine-tune again. After the noise has been reduced, readjust the picture so that it is aligned on 
the centre of screen.

PC Position
Adjust the PC’s screen positioning if it does not fit the TV screen. 
Press the ▲ or ▼ button to adjusting the Vertical-Position. Press the ◄ or ► button to adjust 
the Horizontal-Position.

Image Reset
You can replace all image settings with the factory default values.
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Configuring the Sound Menu

Mode	→	Standard	/	Music	/	Movie	/	Clear	Voice	/	Custom
Press the TOOLS button to display the Tools menu. You can also set the sound mode by 
selecting Tools → Sound Mode.
Standard: Selects the normal sound mode.
Music: Emphasizes music over voices.
Movie: Provides the best sound for movies.
Clear Voice: Emphasizes voice over other sounds.
Custom: Recalls your customized sound settings.

Equalizer
The sound settings can be adjusted to suit your personal preferences.

Mode: Selects the sound mode among the predefined settings.
Balance L/R: Adjusts the balance between the right and left speaker.
�00Hz / �00Hz / �KHz / �KHz / �0KHz (Bandwidth Adjustment): To adjust the level of different bandwidth frequencies.
Reset: Resets the equalizer settings to the default values.

SRS	TruSurround	HD	→	Off	/	On
SRS TruSurround HD is a patented SRS technology that solves the problem of playing 5.1 multichannel content over two 
speakers. TruSurround delivers a compelling, virtual surround sound experience through any two-speaker playback system, 
including internal television speakers. It is fully compatible with all multichannel formats.

Press the TOOLS button to display the Tools menu. You can also set the SRS TruSurround HD by selecting Tools	→	SRS	TS	
HD.
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Brightness	 :	45
Sharpness	 :	75

Auto	Adjustment	 	 ▶

Screen
Advanced	Settings
Picture	Options
Picture	Reset

Picture

Coarse	 	 	 50
Fine	 	 	 0
PC	Position
Image	Reset

U	Move					E	Enter					R	Return

Screen

Mode	 :	Custom	 ▶

Equalizer
SRS	TruSurround	HD	 :	Off
Auto	Volume	 :	Off
Speaker	Select	 :	TV	Speaker
Sound	Select	 :	Main
Sound	Reset

Sound
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Auto	Volume	→	Off	/	On
Each broadcasting station has its own signal conditions, and so it is not easy to adjust the volume every time the channel is 
changed. This feature lets you automatically adjust the volume of the desired channel by lowering the sound output when the 
modulation signal is high or by raising the sound output when the modulation signal is low.

Speaker Select
When you watch TV with it connecting to a Home theatre, turn the TV speakers off so you can listen to sound from the Home 
theatre’s (external) speakers.

External Speaker: Used to listen to the sound of the External (Home Theatre) Speakers.
TV Speaker: Used to listen to the sound of the TV Speakers.

The volume and MUTE buttons do not operate when the Speaker Select is set to External Speaker.
If you select External Speaker in the Speaker Select menu, the sound settings will be limited.

TV’s Internal Speakers Audio Out (L/R Out) to Sound System
RF / AV / Component / PC / HDMI RF / AV / Component / PC / HDMI

TV Speaker Sound Output Sound Output
External Speaker Mute Sound Output
Video No Signal Mute Mute

Sound	Select	→	Main	/	Sub
When the PIP feature is activated, you can listen to the sound of the sub (PIP) picture.

You can select this option when PIP is set to On.
Press the TOOLS button to display the Tools menu. You can also set the sound of the sub picture by selecting Tools	→	PIP	
→	Sound	Select.

Sound	Reset	→	Reset	All	/	Reset	Sound	Mode	/	Cancel
You can restore the Sound settings to the factory defaults.

Reset Sound Mode: Current sound values return to default settings.

Selecting the Sound Mode
You can set the sound mode by pressing the DUAL button. When you press it, the current sound mode is displayed on the screen.

Audio Type Dual � / � Default

A2 Stereo
Mono MONO

Automatic change
Stereo STEREO ↔ MONO
Dual DUAL � ↔ DUAL � DUAL �

NICAM 
Stereo

Mono MONO
Automatic change

Stereo MONO ↔ STEREO

Dual MONO ↔ DUAL � 
DUAL � DUAL �

If the stereo signal is weak and an automatic switching occurs, then switch to the mono.
This function is only activated in stereo sound signal. It is deactivated in mono sound signal.
This function is only available in TV mode.

❑

❑

●
●

N
N

❑

N
T

❑

N

¦

N
N
N

Sound	Reset

	L	Move					E	Enter					R	Return

Cancel	sound	reset.

Reset	All Reset	Sound	Mode Cancel
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SETUP

Configuring the Setup Menu

Language
You can set the menu language.

Time
For detailed procedures on setting up options, refer to the ‘Setting the Time’ instructions. (refer 
to pages 20~21)

Game	Mode	→	Off	/	On 
When connecting to a game console such as PlayStation™ or Xbox™, you can enjoy a more realistic gaming experience by 
selecting game menu.

Restrictions on game mode (Caution)
To disconnect the game console and connect another external device, set Game Mode to Off in the setup menu.
If you display the TV menu in Game Mode, the screen shakes slightly.

Game Mode is not available in regular TV and PC mode.
While PIP is in operation, the Game Mode function cannot be used.
If the picture is poor when external device is connected to TV, check if Game Mode is On. Set Game Mode to Off and 
connect external devices.
If Game Mode is On:

Picture mode is automatically changed to Standard and cannot be changed.
Sound mode is automatically changed to Custom and cannot be changed. Adjust the sound using the equalizer.

The Reset Sound function is activated. Selecting the Reset function after settings the equalizer resets the equalizer settings to 
the factory defaults.

BD	Wise	→	Off	/	On
Provides the optimal picture quality for SAMSUNG DVD, Blu-ray and Home Theatre products which support BD Wise. You can 
enjoy a richer picture when using them connected to this Samsung TV.

Connect SAMSUNG products that have BD Wise using an HDMI cable.
BD Wise is available in HDMI mode.
When the BD Wise set to On, the picture mode is automatically changed to the optimal resolution.

Network Type / Network Setup
For detailed procedures on setting up options, refer to the ‘Setting the Network’ instructions. (refer to pages 24~26)

Child	Lock	→	Off	/	On
This feature allows you to prevent unauthorized users, such as children, from watching unsuitable programme by muting out video 
and audio.

Before the setup screen appears, the PIN number input screen appears. Enter your 4 digit PIN number.
The default PIN number of a new TV set is 0-0-0-0. You can change the PIN by selecting Change PIN from the menu.
You can lock some channels in Channel List. (refer to page 10)
Child Lock is available only in TV mode.

Change PIN
You can change your personal ID number that is required to set up the TV.

Before the setup screen appears, the PIN number input screen appears. Enter your 4 digit PIN number.
The default PIN number of a new TV set is 0-0-0-0.
If you forget the PIN code, press the remote control buttons in the following sequence, which resets the PIN to 0-0-0-0: 
POWER (Off) → MUTE → 8 → 2 → 4 → POWER (On).
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Light	Effect	→	Off	/	In	Standby	/	Watching	TV	/	Always
You can turn on/off the LCD on the front of TV according to the situation. Use it for saving power or when the LCD dazzles your 
eyes.

Off: LCD will not com e on.
In Standby: Turns the LCD on in standby mode.
Watching TV: Turns the LCD on while watching TV.
Always: LCD is always on.
Set the Light Effect to Off to reduce the power consumption.

Melody	→	Off	/	Low	/	Medium	/	High
A melody sound can be set to come on when the TV is powered On or Off.

The Melody does not play
When no sound is output from the TV because the MUTE button has been pressed.
When no sound is output from the TV because the volume has been reduced to minimum with the VOL – button.
When the TV is turned off by Sleep Timer function.

Energy Saving →	Off	/	Low	/	Medium	/	High	/	Auto
This feature adjusts the brightness of the TV in order to reduce power consumption. When watching TV at night, set the Energy 
Saving mode option to High to reduce eye fatigue as well as power consumption.

Press the TOOLS button to display the Tools menu. You can also set the Energy Saving option by selecting Tools	→	Energy	
Saving.

PIP
For detailed procedures on setting up options, refer to page 15.

Setting the Time

Clock
Setting the clock is necessary in order to use the various timer features of the TV.

The current time will appear every time you press the INFO button.
If you disconnect the power cord, you have to set the clock again.

Clock Set
You can set the current time manually.

You can set the day, month, year, hour and minute directly by pressing the number buttons 
on the remote control.

Sleep Timer
The sleep timer automatically shuts off the TV after a preset time (30, 60, 90, 120, 150 and 180 
minutes).

Press the TOOLS button to display the Tools menu. You can also set the sleep timer by 
selecting Tools	→	Sleep	Timer.
To cancel the Sleep Timer function, select Off.

Timer � / Timer � / Timer �
Three different on / off timer settings can be made. 
You must set the clock first.

On Time
Set the hour, minute and activate / inactivate.
(To activate timer with the setting you’ve chosen, set to Activate.)

Off Time
Set the hour, minute and activate / inactivate.
(To activate timer with the setting you’ve chosen, set to Activate.)

❑

●
●
●
●
N

❑

N
�
�
�

❑

T

❑

¦

❑

O
N

■

N

❑

T

N

❑

■

■

Clock	 :		--	:	--	 	 ▶
Sleep	Timer	 :	Off
Timer	1	 :	Inactivated
Timer	2	 :	Inactivated
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Plug	&	Play
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Game	Mode	 :	Off
BD	Wise	 :	Off
Network	Type	 :	Cable
Network	Setup
Child	Lock	 :	On
Change	PIN
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Setup
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[750-���]BN68-02088H-00Eng.indb   20 2009-03-31   �� 2:23:37



English - ��

Volume
Set the desired volume level.

Source	→	TV	/	USB	/	TV	Memory
You can select the TV, TV Memory or USB device content to be played when the TV turns on automatically. Select TV, TV Memory 
or USB. (Make sure that an USB device is connected to your TV.)

When there is only one photo file in the USB or the TV memory, the Slide Show will not play.

Channel (when Source is set to TV)
Select the desired channel.

Contents (when Source is set to USB or TV Memory)
You can select a folder on the USB Device/TV memory with music or photo files to be played when the TV turns on automatically.

If the folder name is too long, the folder can not be selected.
If you are using two of the same type USB device, be sure the folder names are different so the correct USB is read.

Repeat
Select Once, Everyday, Mon~Fri, Mon~Sat, Sat~Sun or Manual.

When Manual is selected, press the ► button to select the desired day of the week. Press the ENTERE button over the 
desired day and the c mark will appear.
You can set the hour, minute and channel by pressing the number buttons on the remote control.
Auto Power Off
When you set the timer On, the television will eventually turn off, if no controls are operated for 3 hours after the TV was 
turned on by the timer. This function is only available in timer On mode and prevents overheating, which may occur if a TV is 
on for too long time.

Network Connection
You can set up the Internet Protocol so that you can communicate with various connected networks.

Network Connection - Cable

LAN Connection for a DHCP Environment
The procedures to set up the network using Dynamic Host Configuration Protocol (DHCP) are described below. Since an IP 
address, subnet mask, gateway, and DNS are automatically allocated when DHCP is selected, you do not have to enter them 
manually.
�. Connect the LAN port on the rear panel of the TV and the external modem with a LAN Cable.
�. Connect the Modem port on the wall and the external modem with a Modem Cable.

You can connect the LAN via a Sharer (Router).
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TV Rear Panel
The Modem Port on the Wall External Modem 

(ADSL / VDSL / Cable TV)

1 LAN Cable2 Modem Cable

TV Rear PanelThe Modem Port on the Wall External Modem 
(ADSL / VDSL / Cable TV)

LAN CableModem Cable LAN Cable

IP Sharer
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You can connect the LAN port and the TV directly depending on your network status.

The terminals (the position of the port and the type) of the external device may differ depending on the manufacturer.
If the IP address allocation by the DHCP server has failed, turn the external modem off, turn it on again after at least 10 
seconds and then try again.
For the connections between the external modem and the Sharer (Router), refer to the owner’s manual of the corresponding 
product.
You can connect the TV to the LAN directly without connecting it through a Sharer (Router)
You cannot use a manual-connection-type ADSL modem because it does not support DHCP. You have to use an automatic-
connection-type ADSL modem.

LAN Connection for Static IP Environment
The procedures to set up the network using a static IP address are described below. You have to manually enter the IP address, 
subnet mask, gateway, and DNS that are provided by your Internet Service Provider (ISP). 
�. Connect the LAN port on the rear panel of the TV and the LAN port on the wall using the LAN cable.

You can connect the LAN via a Sharer (Router).

The terminals (the position of the port and the type) of the external device may differ depending on the manufacturer.
If you are using a static IP address, your ISP will inform you of the IP address, subnet mask, gateway, and DNS. You must 
enter these values to complete the network settings. If you do not know the values, ask your network administrator.
For the information on how to configure and connect a Sharer (Router), refer to the owner’s manual for the corresponding 
product.
You can connect the TV to the LAN directly without connecting it through a Sharer (Router).
If you use an IP Sharer (IP Router) that supports DHCP, you can set up the device as either DHCP or static IP.
For the procedures to use a static IP address, ask your Internet Service Provider.
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TV Rear PanelThe LAN Port on the Wall

LAN Cable

TV Rear PanelThe LAN Port on the Wall
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Network Connection - Wireless
You can connect to the network wirelessly through a wireless IP sharer.

�. Connect the ‘Samsung Wireless LAN Adapter’ into the USB�(HDD) or USB� terminal of the TV.
You must use the ‘Samsung Wireless LAN Adapter’(WIS09ABGN) to use a wireless network.
Samsung’s Wireless LAN adapter is sold separately. The WIS09ABGN Wireless LAN adapter is offered by select 
retailers, Ecommerce sites and Samsungparts.com.
To use a wireless network, your TV must be connected to a wireless IP sharer. If the wireless IP sharer supports DHCP, 
your TV can use a DHCP or static IP address to connect to the wireless network.
Samsung’s Wireless LAN adapter supports IEEE 802.11A, IEEE 802.11B, IEEE 802.11G, IEEE 802.11N. When you play 
DLNA video over IEEE 802.11B/G connection, the video may not be played smoothly.
If the wireless IP sharer allows you to turn the Ping connection function on/off, turn it on.
Select a channel for the wireless IP sharer that is not currently being used. If the channel set for the wireless IP sharer is 
currently being used by another device nearby, this will result in interference and communications may fail.
If you apply a security system other than the systems listed blow, it will not work with the TV. 

When applying the security key for the AP (wireless IP sharer), only the following is supported.
1) Authentication Mode : OPEN, SHARED, WPAPSK, WPA2PSK
2) Encryption Type : WEP, TKIP, AES
When applying the security key for the Ad-hoc mode, only the following is supported.
1) Authentication Mode : SHARED, WPANONE
2) Encryption Type : WEP, TKIP, AES

If your AP supports WPS(Wi-Fi Protected Setup), you can connect to the network via PBC (Push Button Configuration) or 
PIN (Personal Indentification Number). WPS will automatically configure the SSID and WPA key in either mode.
If the device isn’t certified, it may not connect to the TV via the ‘Samsung Wireless LAN Adapter’.
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Setting the Network

Network Type
Select Cable or Wireless as the method to connect to the network.

The menu is activated only if the ‘Samsung Wireless LAN Adapter’ is connected. 

Cable
Connect to the network using a cable.

Wireless
Connect to the network wirelessly.

Network Setup 

Cable Network Setup 
(when Network Type is set to Cable)

Please check if the LAN cable is connected.
Internet	Protocol	Setup	→	Auto	/	Manual
Network Test: You can test or confirm the network connection status after setting up the network.
When unable to connect to a wired network
If your Internet service provider has registered the MAC address of the device used to connect to the Internet for the first time 
and authenticates the MAC address each time you connect to the Internet, your TV may not be able to connect to the Internet 
as the MAC address differs from that of the device (PC).
In this case, ask your Internet service provider about the procedures to connect devices other than your PC (such as your TV) 
to the Internet. If your Internet service provider requires an ID or password to connect to the Internet (network), your TV may 
not be able to connect to the Internet. In this case, you have to enter your ID or password when connecting to the Internet 
using an Internet Sharer (Router).
The internet connection may fail due to a firewall problem. In this case, contact your Internet service provider. If you cannot 
connect to the Internet even if you have followed the procedures of your Internet service provider, please contact Samsung 
Electronics.

Cable Network Setup-Auto
If you connect the LAN cable and it supports DHCP, the Internet Protocol (IP) Settings are 
automatically configured. 
�. Set Network Type to Cable.
�. Select Cable Network Setup.
�. Set Internet Protocol Setup to Auto.

The Internet Protocol is set automatically.
�. Select Network Test to check the network connectivity.

Cable Network Setup-Manual 
To connect the TV to the LAN using a static IP address, you must set up the Internet Protocol 
(IP). 
�. Set Network Type to Cable.
�. Select Cable Network Setup.
�. Set Internet Protocol Setup to Manual.
�. Set up IP Address, Subnet Mask, Gateway and DNS Server.

Press the number buttons on the remote control when you set the Network manually.
�. Select Network Test to check the network connectivity.

Wireless Network Setup
The menu is activated only if the ‘Samsung Wireless LAN Adapter’ is connected.
Internet	Protocol	Setup	→	Auto	/	Manual
Network Test: You can test or confirm the network connection status after setting up the network.
When unable to connect to an AP(Access Point)
Your TV may fail to locate an AP(Access Point) that is configured as a private SSID type. In this case, please change the AP 
settings and try again. If your Internet service provider has registered the MAC address of the device used to connect to the 
Internet for the first time and authenticates the MAC address each time you connect to the Internet, your TV may not be able 
to connect to the Internet as the MAC address differs from that of the device (PC).
In this case, ask your Internet service provider about the procedures to connect devices other than your PC (such as your TV) 
to the Internet. If you cannot connect to the Internet even if you have followed the procedures of your Internet service provider, 
please contact a Samsung Electronics.
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Select a network
Access Point: You can select the IP sharer to use when using a wireless network.

If a wireless Access Point is not in the Access Point list, press the Red button.
When the connection is made, you will be returned to the screen automatically.
If you have selected an Access Point with a security authentication: The Security 
Key input screen appears. Enter the security key and press the Blue button on 
the remote control.
If security encryption type is WEP, 0~9, A~F will be available when you input 
security key.

Connecting WPS (Wi-Fi Protected Setup)
If Security Key is already set: In access point list, select WPS.

You can select PBC, PIN, Security Key.

Connecting by using PBC: Select a PBC (Push Button Configuration). Press the PBC 
button on the AP (access point) within 2minutes, and wait for connection.

Connecting by using PIN: Select a PIN (Personal Identification Number). 
The message showing the PIN Code is displayed. Input the PIN Code at AP 
device within 2minutes. Select OK and wait for connection.
Try again if connecting operation doesn’t work
When the connection is not established although tried again, reset the access 
point. Please refer to a manual of each access point.

Connecting by using Security Key: When selecting Security Key, the input window 
is displayed. Input the security key and press Blue button.

Try again if connecting operation doesn’t work.

If Security Key is not set: When the security setting of AP that supports WPS is NONE, 
you can select PBC, PIN, None Security. None Security is capable of connecting to AP 
directly without using WPS function.

Process of PBC, PIN is same as above. Refer to if Security Key is already set.
Try again if connecting operation doesn’t work.
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Ad-hoc: You can connect to a mobile device without an access point through the ‘Samsung Wireless LAN Adapter’ by 
using a peer to peer network.

How to connect to new Ad-hoc
�. Choose Select a network, then a device list is displayed.
�. While in the device list, press the Blue button on the remote or select Ad-

hoc.
The message The existing network system may have limited 
functionality. Do you want to change the network connection? is 
displayed.

�. Input the generated Network Name(SSID) and Security Key into the 
device you want to connect.

N

How to connect an existing Ad-hoc device
�. Choose Select a network, the device list is displayed.
�. Select the device you want in the Device list.
�. If security key was applied, input the security key again.

If network doesn’t operate normally, please check the Network 
Name(SSID) and Security Key again. If the Security Key is incorrect, 
it may be the reason for the malfunction.

N

Wireless Network Setup-Auto
If you want to connect AP, AP should support DHCP. Only devices which support Ad-hoc mode 
can be connected without DHCP.
�. Set Network Type to Wireless.
�. Select Wireless Network Setup.
�. Set Internet Protocol Setup to Auto.

The Internet Protocol is set automatically.
�. Select a network through Select a network.
�. Select Network Test to check the network connectivity.

Wireless Network Setup-Manual
�. Set Network Type to Wireless.
�. Select Wireless Network Setup.
�. Set Internet Protocol Setup to Manual.
�. Set up IP Address, Subnet Mask, Gateway and DNS Server.

Press the number buttons on the remote control when you set the Network manually.
�. Select a network through Select a network.
�. Select Network Test to check the network connectivity.
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Network	Test
Select	a	network		 :	AP1
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Gateway	 :	 0			 0			 0			 0	
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The	existing	network	system	may	have	limited	
functionality.	Do	you	want	to	change	the	network	
connection?
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INPUT / SUPPORT

Input Menu

Source List
Use to select TV or other external input sources such as DVD / Blu-ray players / Cable Box / 
Satellite receivers (Set-Top Box) connected to the TV. Use to select the input source of your 
choice.

Press the SOURCE button on the remote control to view an external signal source. TV 
mode can be selected by pressing the TV button.

TV / AV� / AV� / Component� / Component� / PC / HDMI� / HDMI� / HDMI�/DVI / HDMI� / 
USB

You can choose only those external devices that are connected to the TV. In the Source 
List, connected inputs will be highlighted and sorted to the top. Inputs that are not 
connected will be sorted to the bottom.
If USB devices are connected to the USB�(HDD) and USB� jacks, they are displayed as 
USB1 and USB2 in order.
Using the Colour buttons on the remote with the Source list

Red (Refresh): Refreshes the connected external devices. Press this if your Source is 
on and connected, but does not appear in the list.
TOOLS (Tools): Displays the Edit Name and Information menus.

PC always stays activated.

Edit Name

VCR / DVD / Cable STB / Satellite STB / PVR STB / AV Receiver / Game / Camcorder / PC / DVI / DVI PC / TV / IPTV / Blu-ray 
/ HD DVD / DMA
Name the device connected to the input jacks to make your input source selection easier.

When a PC with a resolution of 1920 x 1080@60Hz is connected to the HDMI IN �(DVI) port, you should set the HDMI�/DVI 
mode to DVI PC in the Edit Name of the Input mode.
When connecting an HDMI/DVI cable to the HDMI IN �(DVI) port, you should set the HDMI�/DVI mode to DVI or DVI PC in 
the Edit Name of the Input mode. In this case, a separate sound connection is required.

Support Menu

Product Guide
The Product Guide gives you information on the most important features of this TV.
The descriptions provided by this function are in English only.

Picture Quality Full HD �0�0p

��0Hz Motion Plus

Picture Mode

Medi@�.0 Internet@TV-Content Service

Content Library Flash

USB�.0 Movie

DLNA Wireless

Eco-Friendly Energy Saving Mode

Eco Material

Using the Remote Control Buttons in the Product Guide Menu
Button Operations

Yellow Button Shows the contents of the Product Guide sequentially. (Auto Play)
◄/► Move the cursor and select an item.

ENTERE Select the currently selected item.
RETURN Return to the previous menu.

EXIT Stop the current function and return to the Product Guide main menu.
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Self Diagnosis

Picture Test
If you think you have a picture problem, perform the picture test. Check the colour pattern on 
the screen to see if the problem still exists.

Yes: If the test pattern does not appear or there is noise in the test pattern, select Yes. 
There may be a problem with the TV. Therefore, contact Samsung’s call centre for 
assistance.
No: If the test pattern is properly displayed, select No. There may be a problem with your external equipment. Please check 
your connections. If the problem still persists, refer to the external device’s user manual.

Sound Test
If you think you have a sound problem, please perform the sound test. You can check the sound by playing a built-in melody sound 
through the TV.

If you hear no sound from the TV’s speakers, before performing the sound test, make sure Speaker Select is set to TV 
speaker in the Sound menu.
The melody will be heard during the test even if Speaker Select is set to External Speaker or the sound is muted by pressing 
the MUTE button.
Yes: If during the sound test you can hear sound only from one speaker or not at all, select Yes. There may be a problem with 
the TV. Therefore, contact Samsung’s call centre for assistance.
No: If you can hear sound from the speakers, select No. There may be a problem with your external equipment. Please check 
your connections. If the problem still persists, refer to the external device’s user manual.

Software Upgrade
Samsung may offer upgrades for the TV’s firmware in the future. These upgrades can be 
performed via the TV when it is connected to the Internet, or by downloading the new firmware 
from samsung.com to a USB memory device.

Current Version is the software already installed in the TV.
Alternative Software (Backup) shows the previous version that will be replaced.
Software is represented as ‘Year/Month/Day_Version’. The more recent the date, the newer 
the software version. Installing the latest version is recommended.

BY USB
Insert a USB drive containing the firmware upgrade downloaded from samsung.com into the 
TV. Please be careful to not disconnect the power or remove the USB drive while upgrades 
are being applied. The TV will turn off and turn on automatically after completing the firmware 
upgrade. Please check the firmware version after the upgrades are complete (the new version 
will have a higher number than the older version). When software is upgraded, video and audio 
settings you have made will return to their default (factory) settings. We recommend you write 
down your settings so that you can easily reset them after the upgrade.

Alternative Software (Backup)
If there is an issue with the new firmware and it is affecting operation, you can change the 
software to the previous version.

If software was changed, existing software is displayed.
You can change current software to alternative software by Alternative Software.

HD Connection Guide
This menu presents the connection method that provides the optimal quality for the HD TV. Refer to this information when 
connecting external devices to the TV.

Contact Samsung
View this information when your TV does not work properly or when you want to upgrade the software. You can view the 
information regarding the call centre, product and software file download method.
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MEDIA PLAY (USB&DLNA)

Connecting a USB Device

�. Press the POWER button to turn the TV on.
�. Connect a USB device containing photo, music and/or movie files to the USB�(HDD) or USB� 

jack on the side of the TV.
�. When the Application selection screen is displayed, press the ENTERE button to select 

Media Play (USB & DLNA).
MTP (Media Transfer Protocol) is not supported.
The file system supports FAT16, FAT32 and NTFS.
Certain types of USB Digital camera and audio devices may not be compatible with this 
TV.
Media Play only supports USB Mass Storage Class devices (MSC). MSC 
is a Mass Storage Class Bulk-Only Transport device. Examples of MSC 
are Thumb drives, Flash Card Readers and USB HDD (USB HUB are not 
supported.). 
Please connect directly to the USB port of your TV. If you are using a separate 
cable connection, there may be a USB compatibility problem.
Before connecting your device to the TV, please back up your files to prevent 
them from damage or loss of data. SAMSUNG is not responsible for any data 
file damage or data loss.
Connect a USB HDD to the dedicated port, USB� (HDD) port. However, if the 
connected device requires high power, the USB� (HDD) may fail to support 
the device.
Do not disconnect the USB device while it is loading.
MSC supports MP3 and JPEG files, while a PTP device supports JPEG files only.
The higher the resolution of the image, the longer it takes to display on the screen.
The maximum supported JPEG resolution is 15360X8640 pixels. 
For unsupported or corrupted files, the ‘Not Supported File Format’ message is displayed.
If sort key is set to Basic View, up to 1000 files can be displayed in each folder. The other sort key can display up to 10000 
files.
MP3 files with DRM that have been downloaded from a non-free site cannot be played. Digital Rights Management (DRM) 
is a technology that supports the creation of content, the distribution and management of the content in an integrated 
and comprehensive way, including the protection of the rights and interests of the content providers, the prevention of the 
illegal copying of contents, as well as managing billings and settlements.
When moving to a photo, loading may take a few seconds. At this point, the loading icon will appear at the screen. 
If more than 2 PTP devices are connected, you can only use one at a time. 
If more than one MSC device is connected, some of them may not be recognized. If a device requires high power (more 
than 500mA or 5V), the USB device may not be supported. 
If an over-power(Fail add new device USB1/USB2 Power Overload) warning message is displayed while you are 
connecting or using a USB device, the device may not be recognized or may malfunction.

Using the Remote Control Button in Media Play Menu
Button Operations

▲/▼/◄/► Move the cursor and select an item.

ENTERE
Select the currently selected item. While playing a slide show, movie, or music file:
- Pressing the ENTERE button during play pauses the play.
- Pressing the ENTERE button during pause resumes the play.

∂/∑ Play or pause the Slide Show, music or movie.
RETURN Return to the previous menu.
TOOLS Run various functions from the Photo, Music and Movie menus.

∫ Stop the current slide show, Music or Movie file.
π/μ Jump to previous group/Jump to next group.

INFO Show file information.
MEDIA.P Exit Media Play mode.

< P >, EXIT, TV Stop Media Play mode and Returns to TV mode.
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Media Play Function
This function enables you to view and listen to photo, music and/or movie files saved on a USB Mass Storage Class (MSC) device.

Entering the Media Play (USB & DLNA) Menu
�. Press the MENU button. Press the ▲ or ▼ button to select Application, then 

press the ENTERE button.

�. Press the ▲ or ▼ button to select Media Play (USB & DLNA), then press the 
ENTERE button.

The Media Play (USB & DLNA) menu is displayed.

Press the MEDIA.P button on the remote control to display the Media Play 
menu.

Press the SOURCE button on the remote control to view the source list. 
Then Press the ▲ or ▼ button to select USB. 

�. Press the Red button, then press the ▲ or ▼ button to select the TV memory or 
USB Memory. Press the ENTERE button.

This function differs depending on the TV Memory / USB Memory Device / 
DLNA device.
The selected USB device name appears at the bottom left of the screen.

�. Press the ◄ or ► button to select an icon (Photo, Music, Movie, Setup), then 
press the ENTERE button. 

To exit Media Play mode, press the MEDIA.P button on the remote control.

Removing a USB Memory Device Safely
You can remove the device safely from the TV.
�. Press the TOOLS button in the Media Play file list screen, or while a Slide Show, music or movie is being played.
�. Press the ▲ or ▼ button to select Remove Safely, then press the ENTERE button.
�. Remove the USB device from the TV.

Screen Display

Move to either ‘Sort key List Section’, ‘Group List Section’ or ‘File List Section’ using the Up and Down buttons. After selecting a 
section, press the ◄ or ► buttons to select an item.
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1 Current Sort key: This field shows the current standard for sorting files. Press the ◄ or ► button to change the standard for 
sorting files.

2 View Groups: Shows the detailed groups of the files sorted according the selected Sort key. The sort group where the currently 
selected file is contained is highlighted.

3 Currently selected file: The selected file is the file you can now control. Photo and movie files are displayed as thumbnail 
images.

4 Current Device: Shows the currently selected device name. Press the Red button to select a device.
Red (Device) button: Selects a connected device.

5 Help Items
Green (Favourites Settings) button: Changes the Favourites Settings for the selected file. Press this button repeatedly 
until the desired value appears.
Yellow (Select) button: Selects file from the file list. Selected files are marked with a symbol c. Press the Yellow button 
again to cancel a file selection.
TOOLS (Tools) button: Displays the option menus. (The option menu changes according to the current status.)

6 Item Selection Information: Shows the number of files that are selected by pressing the Yellow button.

Sorting the Photo List
You can sort photos in the Photo List by a particular standard.
�. Press the MEDIA.P button.
�. Press the ◄ or ► button to select Photo, then press the ENTERE button. 
�. Press the ▲ button to move to the Sort key Section.
�. Press the ◄ or ► button to select a sorting standard. (Basic View, Timeline, 

Colour, Folder, Preference)
The photos are sorted according to the newly selected sorting standard.

�.  Press the ▼ button to move to the File List Section. Press the ∂ (Play)/
ENTERE button to start the Slide Show in the order you selected.

To move to the previous/next group, press the π (REW) or μ (FF) button.
Photo information is automatically set. The colour information extracted from a photo file may be different from your 
expectations. You can change the colour and preference.
PTP does not support folder sort mode.

Basic View
Shows the folders on the USB memory device. If you select a folder and press the ENTERE button, only the photo files 
contained in the selected folder are displayed.

When sorted according to the Basic View, you cannot set Favourites files.

Timeline
Sorts photos by date. It sorts by year and month from the earliest photo.

Colour	→	Red	/	Yellow	/	Green	/	Blue	/	Magenta	/	Black	/	Gray	/	Unclassified
Sorts photos by colour. You can change the photo colour information.

You should set the Use Colour View to on in the Setup menu before sorting photos by colour.

Folder
Sorts photos by folder. If there are many folders in USB, the photos files are shown in order in each folder. The photo file in the 
Root folder is shown first and the others are shown in alphabetical order by name.

Preference	→	FFF / FFF / FFF / FFF
Sorts photos by preference (Favourites). You can change the photo preferences.

Changing the Favourites Settings
Select the desired photo in the Photo list, then press the Green button repeatedly until the desired setting appears.
Up to 3 stars can be selected.
The stars are for grouping purposes only. For example, the 3 star setting does not have any priority over the one star setting.
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Photo List Option Menu

�. Press the MEDIA.P button.
�. Press the ◄ or ► button to select Photo, then press the ENTERE button. 
�. Press the ▼ button to move to the File List Section.
�. Press the ◄ or ► button to select the desired photo file.

Selecting Multiple Photos
Press the ◄ or ► button to select the desired photo file. Then press the Yellow button.
Repeat the above operation to select multiple photo files.
The mark c appears to the selected photo file.

�. Press the TOOLS button.
The option menu changes according to the current status.

Slide Show
Using this menu, you can play a SlideShow using the photo files on the USB memory 
device.

Copy / Copy Current Group / Copy the selected file (When multiple files 
are selected)
Select a photo you want to copy. (Alternatively, select multiple files by pressing the 
Yellow button.) Press the TOOLS button to select Copy (or Copy Current Group / 
Copy the selected file). The files on the USB device are saved to the TV memory.

You can only copy the files saved on the USB device. 
When the TV memory is full, files cannot be copied.

Delete / Delete All / Delete Selected File (When multiple files are selected)
Select a photo to delete. (Alternatively, select multiple files by pressing the Yellow button.) Press the TOOLS button to select 
Delete (or Delete All / Delete Selected File). The files are deleted.

You can only delete the files saved in the TV memory.
You cannot recover a deleted file. 

Play Current Group
Using this menu, you can play a SlideShow using only the photo files in the currently selected sorting group.

Change Group (When the Sort key is the Colour)
You can change a selected photo file’s (or group of files) colour information in order to move it from one colour group to another.

This does not change the actual colour of the photo.
The group information of the current file is updated and the photos are moved to the new colour group.
To change the information of multiple files, select the files you want by pressing the Yellow button.

Deselect All (When at least one file is selected)
You can deselect all files.

The c mark indicating the corresponding file is selected is hidden.

Information
The photo file information including the name, the size, the resolution, the date modified and the path is displayed.

You can view the information of photo files during a SlideShow using the same procedures.
Press the INFO button to viewing the information. 

Remove Safely
You can remove the device safely from the TV.
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Viewing a Photo or Slide Show

Viewing a Slide Show
�. Press the ▼ button to select the File List Section.
�. Press the TOOLS button.
�. Press the ▲ or ▼ button to select Slide Show, then press the ENTERE button.

All files in the photo list will be used for the Slide Show.

During the slide show, files are displayed in order from the currently shown file.

The Slide Show progresses in the order sorted in the Photo list.

Music files can be automatically played during the Slide Show if the Background 
Music is set to On. 

While a photo list is displayed, press the ∂(Play)/ENTERE button on the 
remote control to start slide show.

SlideShow Control Buttons
Button Operations

ENTERE Play/Pause the Slide Show.
∂ Play the Slide Show.
∑ Pause the Slide Show.
∫ Exit Slide Show and return to the photo list.

π/μ Change the SlideShow playing speed.
TOOLS Run various functions from the Photo menus.

Playing current group
�. Press the ▲ button to move to the Sort key Section.
�. Press the ◄ or ► button to select a sorting standard. 
�. Press the ▼ button to move to the Group List Section.
�. Select a group using the ◄ and ► buttons.
�. Press the ∂ (Play) button. A slideshow begins with the files of the selected group.

Alternatively 
�. Select a Sort key and then in the File List Section, select the photos contained in 

the desired group.
To move to the previous/next group, press the π (REW) or μ (FF) button.

�. Press the TOOLS button. 
�. Press the ▲ or ▼ button to select Play Current Group, then press the ENTERE button.

Only the photos in the sorting group including the selected files will be used for the Slide Show.

To	perform	a	Slide	Show	with	only	the	selected	fi	les
�. Press the ▼ button to select the File List Section.
�. Press the ◄ or ► button to select the desired photo in the Photo list.
�. Press the Yellow button.
�. Repeat the above operation to select multiple photos.

The c mark appears to the left of the selected photo.
If you select one file, the Slide Show will not be performed.
To deselect all selected files, press the TOOLS button and select Deselect All.

�. Press the ∂ (Play)/ENTERE button.
The selected files will be used for the Slide Show.
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Alternatively 
�. In the Photo List, press the Yellow buttons to select the desired photos.
�. Press the TOOLS button. 
�. Press the ▲ or ▼ button to select Slide Show, then press the ENTERE button.

The selected files will be used for the Slide Show.

Slide Show Option Menu

�. During a slide show (or when viewing a photo), press the TOOLS button to set the option.
�. Press the ▲ or ▼ button to select the desired option, then press the ENTERE button.

Stop Slide Show / Start Slide Show
You can start or stop a SlideShow.

Slide	Show	Speed	→	Slow	/	Normal	/	Fast
You can select the slide show speed.

This function is available only during a slide show.
You can also change the speed of the Slide Show by pressing the π (REW) or 
μ (FF) button during the Slide Show.

Slide Show Effect 
You can select the screen transition effect used in the slideshow.

None / Fade� / Fade� / Blind / Spiral / Checker / Linear / Stairs / Wipe / Random
This function is available only during a slide show.

Rotate
You can rotate photos saved on a USB memory device.

Whenever you press the ◄ button, it rotates by 270˚, 180˚, 90˚, and 0˚.
Whenever you press the ► button, it rotates by 90˚, 180˚, 270˚, and 0˚. 
The rotated file is not saved.

Zoom
You can magnify photos saved on a USB memory device. (x1 → x2 → x4)

To move the enlarged photo image, press the ENTERE button, then press the ▲/▼/◄/► buttons. Note that when the 
enlarged picture is smaller than the original screen size, the location change function doesn’t work.
The enlarged file is not saved.

Background Music
You can select background music when watching a Slide Show.

To use this feature, there must be music and photo files stored on the USB device.
Loading music files is needed to change BGM mode. Play music files in music category to load.

Background	Music	→	Off	/	On	
Off: Background music is not played.
On: When the background music is available, if you select On, the music is played back. 

BGM	Mode	→	Mood	/	Selected	File	/	Shuffle
You can select a mode to use for the background music.

BGM	Mood	→	Energetic	/	Rhythmical	/	Sad	/	Exciting	/	Calm
Music with the mood you selected is set as the background music.

If you set BGM Mode to Mood, you can select a mood.

Select Music File (0 File(s) Selected)
Only the selected music file is set as the background music.

If you set BGM Mode to Selected File, you can select a music file.
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Sorting the Music List
You can sort music files in the Music List by a particular standard.
�. Press the MEDIA.P button.
�. Press the ◄ or ► button to select Music, then press the ENTERE button.
�. Press the ▲ button to move to the Sort key Section. 
�. Press the ◄ or ► button to select a sorting standard. (Basic View, Title, Artist, 

Mood, Genre, Folder, Preference)
The Music files are sorted according to the newly selected sorting standard.

�. Press the ▼ button to move to the File List Section. Press the ENTERE button to 
start playing music in the order selected by the user.

To move to the previous/next group, press the π (REW) or μ (FF) button.
Music information is automatically set. The mood information extracted from 
a music file may differ from the expectations of the user. You can change the 
mood and preference.
If there is no title information for a music file, the filename is displayed.
If no information is available for the Artist, Album, Year, or Genre the corresponding item is displayed as blank.

Basic View
Shows the folders of the USB memory device. If you select a folder and press the ENTERE button, only the music files 
contained in the selected folder are displayed.

When sorted according to the Basic View, you cannot set Favourites files.

Title
Sorts the music titles in symbol/number/alphabet/special order, and shows the music file.

Artist
Sorts the music file by artist in symbol/number/alphabet/special order.

Mood	→	Energetic	/	Rhythmical	/	Sad	/	Exciting	/	Calm	/	Unclassified	
Sorts music files by the mood. You can change the music mood information.

Genre
Sorts music files by the genre.

Folder
Sorts music files by the folder. If there are many folders in USB, the files are shown in order in each folder. The music file in the 
Root folder is shown first and the others are shown in alphabetical order by name.

Preference	→	FFF / FFF / FFF / FFF
Sorts music files by preference (Favourites). You can change the music files preferences.

Changing the Favourites Settings
Select the desired music file in the Music list, then press the Green button repeatedly until the desired setting appears. 
Up to 3 stars can be selected.
The stars are for grouping purposes only. For example, the 3 star setting does not have any priority over the one star setting.
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Music List Option Menu

�. Press the MEDIA.P button.
�. Press the ◄ or ► button to select Music, then press the ENTERE button. 
�. Press the ▲ button to move to the File List Section.
�. Press the ◄ or ► button to select the desired Music file. 

Selecting Multiple Music Files
Press the ◄ or ► button to select the desired music file. Then press the 
Yellow button.
Repeat the above operation to select multiple music files.
The mark c appears to the selected music file.

�.  Press the TOOLS button.
The option menu changes according to the current status.

Play Current Group
Using this menu, you can only play music files in the currently selected sorting group.

Copy / Copy Current Group / Copy the selected file (When multiple files are selected)
Select the photo to copy. (Alternatively, select multiple files by pressing the Yellow button.) Press the TOOLS button to select Copy 
(or Copy Current Group / Copy the selected file). The files on the USB device are saved to the TV memory.

You can only copy the files saved on the USB device. 
When the TV memory is full, files cannot be copied.

Delete / Delete All / Delete Selected File (When multiple files are selected)
Select the file to delete. (Alternatively, select multiple files by pressing the Yellow button.) Press the TOOLS button to select Delete 
(or Delete All / Delete Selected File). The files are deleted.

You can only delete the files saved in the TV memory.
You cannot recover a deleted file. 

Change Group Info (When the Sort key is Mood)
You can change the mood information of music files.
The group information of the current file is updated and the file is moved to the new group.

To change the information of multiple files, select files by pressing the Yellow button.

Deselect All (When at least one file is selected)
You can deselect all files.

The c mark indicating the corresponding file is selected is hidden.

Information
The music file information including the name, the size, the date modified and the path is displayed.

You can view the music file information during Play Current Group using the same procedures.
Press the INFO button to viewing the information. 

Remove Safely
You can remove the device safely from the TV.
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Playing a Music

Playing	a	music	file
�. Press the ▼ button to select the File List Section.
�. Press the ◄ or ► button to select a music file to be played.
�. Press the ∂ (Play)/ENTERE button.

This menu only shows files with the MP3 file extension. Files with other 
file extensions are not displayed, even if they are saved on the same USB 
device.
The selected file is displayed at the top with its playing time.
To adjust the music volume, press the volume button on the remote control. 
To mute the sound, press the MUTE button on the remote control.
If the sound is odd when playing MP3 files, adjust the Equalizer and SRS TruSurround HD in the Sound menu. (An 
over-modulated MP3 file may cause a sound problem.)
The playing duration of a music file may be displayed as ‘00:00:00’ if its playing time information is not found at the start of 
the file.
π (REW) or μ (FF) buttons do not function during play.

Music Play Control Buttons
Button Operations

ENTERE Play/Pause the music file.
∂ Play the music file
∑ Pause the music file
∫ Exit play mode and return to the music list.

TOOLS Run various functions from the Music menus.

Music function information icon

p When all music files in the folder (or the selected file) are repeated. Repeat Mode is On.
q When all music files in the folder (or the selected file) are played once. Repeat Mode is Off.

Playing the music group
�. Press the ▲ button to move to the Sort key Section.
�. Press the ◄ or ► button to select a sorting standard.
�. Press the ▼ or ENTERE button to move to the Group List Section.
�. Press the ∂ (Play) button. The files of the selected group will start playing.

Alternatively 
�. Select a sort key and then in the File List Section, select the files contained in the desired group.

To move to the previous/next group, press the π (REW) or μ (FF) button.
�. Press the TOOLS button. 
�. Press the ▲ or ▼ button to select Play Current Group, then press the ENTERE button.

The music files in the sorting group including the selected file are played.

Playing	the	selected	music	files
�. Press the ▼ button to select the File List Section.
�. Press the ◄ or ► button to select the desired music file.
�. Repeat the above operation to select multiple music files.

The c appears to the left of the selected music file.
To deselect all selected files, press the TOOLS button and select Deselect All.

�. Press the ∂ (Play)/ENTERE button.
The selected files will be played.

¦

N

N
N

N

N

N
N

N

●

N

N

N
N

N

E	Pause						◀▶	Previous	/	Next     T	Tools					R	ReturnSUM

	I	Love	You HaHaHaWay

▶												00:00:04	/	00:04:04																																							3/37
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Music Play option Menu

Music Play Option Menu

Repeat	Mode	→	On	/	Off
You can play music files repeatedly.

Picture Setting / Sound Setting
You can configure the picture and sound settings.

Information
The music file information is displayed.

Remove Safely
You can remove the device safely from the TV.

¦

❑

❑

❑

❑

Sorting the Movie List
You can sort movies in the Movie List by a particular standard.
�. Press the MEDIA.P button.
�. Press the ◄ or ► button to select Movie, then press the ENTERE button.
�. Press the ▲ button to move to the Sort key Section.
�. Press the ◄ or ► button to select a sorting standard. (Basic View, Timeline, 

Title, Folder, Preference)
The movie files are sorted according to the newly selected sorting standard.

�. Press the ∂ (Play)/ENTERE button to play the movie in the order selected.
Movie information is automatically set. You can change the preference.

Basic View
Shows the folders of the USB memory device. If you select a folder and press the ENTERE button, only the movie files 
contained in the selected folder are displayed.

When sorted according to the Basic View, you cannot set Favourites files.

Timeline
Sorts movies by date. It sorts by year and month from the earliest movie.

Title
Sorts and displays the movie titles in symbol/number/alphabet/special order.

Folder
If there are many folders in USB, the movies files are shown in order in each folder. The movie file in the Root folder is shown first 
and the others are shown in alphabetical order by name.

Preference	→	FFF / FFF / FFF / FFF
Sorts movies by preference. (Favourites) You can change the movie preferences.

Changing the Favourites Settings
Select the desired movie file in the movie list, then press the Green button repeatedly until the desired setting appears.
Up to 3 stars can be selected.
The stars are for grouping purposes only. For example, the 3 star setting does not have any priority over the one star setting.

¦

N

N

❑

N

❑

❑

❑

❑

N

N
N

Repeat	Mode	 ◀												On													▶
Picture	Setting
Sound	Setting
Information
Remove	Safely

U	Move					L	Adjust					e	Exit

Tools

SUM 		Device 	Favourites	Settings			 	Select			T	Tools		R	Return

Preference Basic	View TimelineFolderTitle

ABCD.avi 1235.avi 1236.avi 1237.avi
1233.avi1232.avi1231.avi

5/15
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Movie List Option Menu

�. Press the MEDIA.P button.
�. Press the ◄ or ► button to select Movie, then press the ENTERE button. 
�. Press the ▲ button to move to the File List Section.
�. Press the ◄ or ► button to select the desired Movie file. 

Selecting Multiple Movie Files
Press the ◄ or ► button to select the desired movie file. Then press the 
Yellow button.
Repeat the above operation to select multiple movie files.
The mark c appears to the selected movie file.

�.  Press the TOOLS button.
The option menu changes according to the current status.

Play Current Group
Using this menu, you can only play movie files in the currently selected sorting group.

Copy / Copy Current Group / Copy the selected file (When multiple files are selected)
Select the movie to copy. (Alternatively, select multiple files by pressing the Yellow button.) Press the TOOLS button to select 
Copy (or Copy Current Group / Copy the selected file). The files on the USB device are saved to the TV memory.

You can only copy the files saved on the USB device. 
When the TV memory is full, files cannot be copied.

Delete / Delete All / Delete Selected File (When multiple files are selected)
Select the file to delete. (Alternatively, select multiple files by pressing the Yellow button.) Press the TOOLS button to select Delete 
(or Delete All / Delete Selected File). The files are deleted.

You can only delete the files saved in the TV memory.
You cannot recover a deleted file. 

Deselect All (When at least one file is selected)
You can deselect all files.

The c mark indicating the corresponding file is selected is hidden.

Information
The movie file information including the name, the size, the date modified and the path is displayed.

Press the INFO button to viewing the information. 

Remove Safely
You can remove the device safely from the TV.

Playing a Movie File

Playing	a	movie	file
�. Press the ▼ button to select the File List Section. 
�. Pressing the ◄ or ► button to select a movie file to be played.
�. Press the ∂ (Play)/ENTERE button.

The selected file is played.
The selected file is displayed at the top with its playing time.
The playing duration of a movie file may be displayed as ‘00:00:00’ if its 
playing time information is not found at the start of the file.
You can watch exciting gaming multimedia files, but the gaming function is not 
supported.

¦

N
�

�
�

N

❑

❑

N
N

❑

N
N

❑

N

❑

O

❑

¦

N
N
N

N

SUM 		Device 	Favourites	Settings			 	Select			T	Tools		R	Return

Preference Basic	View TimelineFolderTitle

ABCD.avi 1235.avi 1236.avi 1237.avi
1233.avi1232.avi1231.avi

5/15 Play	Current	Group
Copy
Copy	Current	Group
Information
Remove	Safely

E	Pause						◀	▶	Jump     T	Tools					R	ReturnSUM

ABC.avi

▶						00:00:01	/	00:05:30																																														3/37
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Supported Subtitle Formats
Name File extention Format

MPEG-4 time-based text .ttxt XML
SAMI .smi HTML

SubRip .srt string-based
SubViewer .sub string-based
Micro DVD .sub or .txt string-based

Supported Video Formats

File Extension Container Video Decoder Support Resolution
Chelsea

*.avi AVI

Divx 3.11/4.x/5.1/6.0 720x576
XviD

1920x1080H.264 BP/MP/HP
MPEG-4 SP
MPEG-4 ASP
Motion JPEG 800x600

*.mkv MKV

Divx 3.11/4.x/5.1/6.0 720x576
XviD

1920x1080H.264 BP/MP/HP
MPEG-4 SP
MPEG-4 ASP
Motion JPEG 800x600

*.asf ASF

Divx 3.11/4.x/5.1/6.0 720x576
XviD

1920x1080
H.264 BP/MP/HP
MPEG-4 SP
MPEG-4 ASP

*.wmv (VC1) Window Media Video v9

*.mp4 MP4 (SMP4)

H.264 BP/MP/HP

1920x1080MPEG-4 SP
MPEG-4 ASP
XVID

*.3gp 3GPP
H.264 BP/MP/HP

1920x1080MPEG-4 SP
MPEG-4 ASP

*.mpg 
*.mpeg 

*.vro 
*.vob 
(ps)

PS

MPEG1 (Program Stream)

1920x1080MPEG2 (Program Stream)

others (ts)
MPEG2 (Transport Stream)

1920x1080H.264 (Transport Stream)
VC1 (Transport Stream)

Video Play Control Buttons
Button Operations

ENTERE Play/Pause the movie file
∂ Play the movie file
∑ Pause the movie file

TOOLS Run various functions from the Movie menus.
∫ Exit play mode and return to the movie list.

◄ / ► Skip forwards or backwards through the movie file. 
▲ / ▼ Move to the first/last of the file.
μ Play the file at double speed. This function may not be supported depending on the codec.

N

N

N
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Playing the movie group
�. Press the ▲ button to move to the Sort key Section.
�. Press the ◄ or ► button to select a sorting standard. 
�. Press the ▼ or ENTERE button to move to the Group List Section.
�. Press the ∂ (Play) button. Only the files of the selected group will start playing.

Alternatively 
�. Select a Sort key and then in the File List Section, select the files contained in the desired group.

To move to the previous/next group, press the π (REW) or μ (FF) button.
�. Press the TOOLS button. 
�. Press the ▲ or ▼ button to select Play Current Group, then press the ENTERE button.

The movie files in the sorting group including the selected file are played.

Playing	the	selected	movie	files
�. Press the ▼ button to select the File List Section.
�. Press the ◄ or ► button to select the desired music file.
�. Press the Yellow button. 

The c mark appears to the left of the selected movie file.
�. Repeat the above operation to select multiple movie files.
�. Press the ∂ (Play)/ENTERE button.

Only the selected file is played.

Playing movie continuously (Resume Play)
If you exit the playing movie function, the movie can be played later from the point where it was stopped.
�. Select the movie file you want to play continuously by pressing the ◄ or ► button to select it from the Movie List.
�. Press the ∂ (Play)/ENTERE button.
�. Select Cont. Movie Play Help (Resume Play) by pressing the Blue button.

The Movie will begin to play from where it was stopped .
If Cont. Movie Play Help function is set On in the Setup menu, a pop-up message will appear when you resume play a 
movie file.

●

N

N

N

N

N
N
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Movie Play Option Menu

Movie Play Option Menu

Picture Setting / Sound Setting
You can configure the picture and sound settings.

Picture Size

Fit
Play video at the TV screen size.

Original
Play video at the original size.

Caption Setting
You can set the captions for the movie.

Caption	→	On	/	Off
You can turn the captions for the movie on or off.

Caption Language
You can set the caption language.

Caption	Size	→	Small	/	Standard	/	Large
You can change the font size of the captions.

Caption Sync
You can adjust the caption sync.

Caption Sync Reset
You can reset the adjusted caption sync.

Information
The movie file information is displayed.

Remove Safely
You can remove the device safely from the TV.

¦

❑

❑

■

■

❑

■

■

■

■

■

❑

❑

Picture	Setting
Sound	Setting
Picture	Size	 :	 Fit
Caption	Setting
Information
Remove	Safely

U	Move					E	Enter					e	Exit

Tools
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Using the Setup Menu
Setup displays the user settings of the Media Play menu.
�. Press the MEDIA.P button.
�. Press the ◄ or ► button to select Setup, then press the ENTERE button.
�. Press the ▲ or ▼ button to select the desired option.
�. Press the ◄ or ► button to select the option, then press the ENTERE button.

To exit Media Play mode, press the MEDIA.P button on the remote control.

Use	Colour	View	→	On	/	Off
You can select sorting photos by colour. If this option is set to On, the loading time may 
be increased to collect colour information from the photos.

Music	Repeat	Mode	→	On	/	Off
Select to repeatedly play music files.

Cont.	movie	play	help	→	On	/	Off
Select to display the help pop-up message for continuous movie playback.

Get the DivX® VOD registration code
Shows the registration code authorized for the TV. If you connect to the DivX web site and register the registration code with a 
personal account, you can download VOD registration file.
If you play the VOD registration using Media Play, the registration is completed.

For more information on DivX® VOD, visit www.DivX.com.

Get the DivX® VOD deactivation code
When DivX® VOD is not registered, the registration deactivation code is displayed.
If you execute this function when DivX® VOD is registered, the current DivX® VOD registration is deactivated.

Screen	Saver	Run	Time	→	2	hours	/	4	hours	/	8	hours
Select to set the waiting time before the screen saver appears.

Information
Select to viewing the information of the connected device.

Remove Safely
You can remove the device safely from the TV.

¦

N

❑

❑

❑

❑

N

❑

❑

❑

❑

851.86MB/993.02MB	Free

Photo

SUM

SUM 		Device

SETUP

e	Exit

Music Movie Setup

Use	Colour	View	 ◀															Off	 ▶
Music	Repeat	Mode	 																		On
Cont.	movie	play	help	 																		On
Get	the	DivX®	VOD	registration	code
Get	the	DivX®	VOD	deactivation	code
Screen	Saver	Run	Time	 													2	hours
Information
Remove	Safely

U	Move				L	Adjust				R	Return

If	this	is	set	to	ON,	the	loading	time	increases	for	collecting	the	colour	
information.

SUM 		Device
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MEDIA PLAY-DLNA

Setting the DLNA Network
DLNA allows you to watch pictures, musics and videos saved on your PC or on your TV through a network connection in Media 
Play mode. This removes the need to copy them to a USB storage device and then connect the device to your TV. To use DLNA, 
the TV must be connected to the network and the DLNA application must be installed on your PC.

Network Connection Diagram-Cable

Network Connection Diagram-Wireless

�. For more information on how to configure your network, refer to ‘Setting the Network’.
You are recommended to locate both TV and PC in same subnet. The first 3 parts of the subnet address of the TV and 
the PC IP addresses should be the same and only the last part (the host address) should be changed. (e.g. IP Address: 
123.456.789.**)

�. Connect the PC to which the Samsung PC Share Manager program will be installed and the external modem using a LAN 
cable.

You can connect the TV to the PC directly without connecting it through a Sharer (Router).

¦

N

N

LAN

1

2

3

External Modem 
(ADSL/VDSL/Cable TV)

TV

PC

LAN

LAN Cable
Wireless IP sharer

TV
PCTV Side Panel

Samsung Wireless 
LAN Adapter

or

Samsung Wireless 
LAN Adapter

[750-���]BN68-02088H-00Eng.indb   44 2009-03-31   �� 2:23:57



English - ��

Installing the DLNA Application
To play content on the PC on the TV, you have to first install the application. To use the DLNA function smoothly, use the 
program in the CD-ROM supplied with the TV or use the Samsung PC Share Manager program corresponding to the TV 
model that can be downloaded from the Samsung web site.

System Requirements
�. Insert the Programme CD supplied with this TV into your PC.
�. 30MB of free hard disk space is needed for the programme installation.

If you share files, up to 30MB of hard disk drive space is required for each 100 files.
If you cancel file sharing, the hard disk drive space used for the thumbnail information is also freed.

Supported Formats
Image: JPEG/ Audio: MP3/ Video: AVI, MKV, ASF, MP4, 3GPP, PS, TS container. For detailed supported video formats, refer 
to the ‘Playing a Movie File’ instructions. (refer to page 40)

Install the application

 



�. Run the Setup.exe file on the Programme CD supplied with the product.
Alternatively, you can download the file from www.samsung.com.

�. Install the SAMSUNG PC Share Manager as shown in the figures.
�. When the installation is complete, the PC Share Manager icon appears on your Desktop.

Double-click the icon to run the programme.

¦

N
N

●

N

N
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Using the DLNA Application

The Programme Screen Layout

1

3 4 5
6 7

2

�. Menus: The following application menus are provided : File, Share, Server, and Help.
�. Click to share the selected PC server folder.
�. Click to cancel sharing.
�. Click to refresh the PC folder and files.
�. Click to synchronize the share status.
�. The folders and files of the PC to be shared are listed.
�. Folders shared by the user are listed.

File

Property
Shows information on the selected file or folder.

Method 1: Select a file or folder and select the File menu and then select the Property sub-menu.
Method 2: Select a file or folder, right-click over the selected file or folder and then select Property from the pop-up menu.

<Method 1> <Method 2>
 

Exit
Exits the DLNA application.
If you select Exit without applying the changes after changing the shared status, a message will appear asking if you want to apply 
the changed settings to the PC. Select Yes to apply the changes and exit the application.

¦

❑

■

●
●

■
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Share

Sharing a Folder
You can share a folder from your PC to the TV. The maximum number of folders that can be shared is 32.

Your PC will operate as a server to the TV.
Method 1: Select a folder in My Computer, select the Share menu and then select the Share Folder sub-menu.
Method 2: Select a folder in My Computer, right-click over the selected folder and then select Share Folder from the popup 
menu.
Method 3: Locate the mouse pointer over a folder in the My Computer folder list in the left pane and drag&drop the folder into 
the Shared Folders pane. If a message appears asking you to confirm the shared folder, select Yes.

<Method 1> <Method 2> <Method 3>

Cancelling a Shared Folder
You can cancel a shared folder on your PC. Select a folder from the Shared Folder pane and select Unshare Folder.

Method 1: Select a folder from the Shared Folder pane, select the Share menu and then select Unshare Folder.
Method 2: Select a folder from the Shared Folder pane, right-click over the selected folder and then select Unshare Folder 
from the pop-up menu.
Method 3: Locate the mouse pointer over a folder in the Shared Folder pane and drag&drop the folder into the My Computer 
pane. If a message appears asking you to confirm the cancelation, select Yes.

<Method 1> <Method 2> <Method 3>

Applying the Current Settings
Perform this when synchronization is necessary due to a new shared folder or cancelling a shared folder. The Set Changed State 
menu applies changes to shared folders to the data saved with the PC share programme.
Since applying changes to the internal data is a time-consuming process, this function enables users to apply changes to the data 
only when required.
Until the Set Changed State menu is selected, the changed state of the shared folder is not applied to the server.
Changes to the shared folders are not applied to your PC until you select the Set Changed State menu.

Method 1: Select the Share menu and select the Refresh DB sub-menu.
Method 2: Click the Set Changed State icon.

<Method 1> <Method 2>
 

❑

■

N
●
●

●

■

●
●

●

■

●
●
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Setting the Access Permission
To enable the TV to find your PC, the TV must be set to Set Device Policy in the Access Permission Settings window. In addition, 
the PC server and the TV must be on the same subnet.

Method: Select the Share menu and select Set Device Policy. Rejected items are represented in gray. You can change the 
access permissions by using the Allow Accept / Deny button. To delete an item, select the item and select Delete Item.

Server

Server
You can run or stop using your PC as a server.

Run DLNA Digital Media Server when Windows Starts
You can determine whether to start the PC server automatically when Windows starts.

Change server name
You can rename the PC server. Enter a new name and click OK. The new name will appear at the top right of the window and will 
appear on the TV.

Help

Version
The program version information message box appears.

Using the DLNA Function

Using the DLNA Menu
DLNA (Digital Living Network Alliance) enables content saved on a DLNA server (usually your PC) connected to your TV or over 
a network to be played. Media Play enables playing content saved on a USB memory device connected to the TV, while DLNA 
enables playing content saved on a DLNA server (your PC) connected to your TV or over the network. The procedures to use the 
content are the same as those for Media Play (USB & DLNA).

If you install the PC share manager program supplied with the TV onto a PC, you can have the PC perform the role of a DLNA 
server over the network.
For detailed procedures on using the DLNA menu, refer to the ‘Media Play’ instructions. (refer to page 29)

�. Press the MEDIA.P button on the remote control to display the DLNA menu.
�. Press the ◄ or ► button to select an icon (Photo, Music, Movie, Setup), then press the ENTERE button.

To exit DLNA mode, press the MEDIA.P button on the remote control.
DLNA does not support the following functions. 

The Background Music and Background Music Setting functions.
Sorting files by preference in the Photo, Music, and Movie folders.
The Change Group Info function.
The Copy / Delete function.
The Remove Safely function.
The REW/FF (π/μ) key functions while a movie is playing.
Playing Movie Continuously (Resume Play) function.

The Skip function may not work with some container such as asf and mkv.
The Divx DRM, Multi-audio, embedded caption does not supported.
Samsung PC Share manager should be permitted by the firewall program on your PC.
The Skip (◄/► keys) or Pause function may not work while a movie is playing for the DLNA of other manufacturers, 
depending on the corresponding content information.
The playing time may not be displayed while a movie is playing.

■

●

❑
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❑
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ANYNET+

Connecting Anynet+ Devices

What is Anynet+?
Anynet+ is a function that enables you to control all connected Samsung devices that support Anynet+ with your Samsung TV’s 
remote. The Anynet+ system can be used only with Samsung devices that have the Anynet+ feature. To be sure your Samsung 
device has this feature, check if there is an Anynet+ logo on it.

To connect to a TV

�. Connect the HDMI IN (�, �, �(DVI) or �) jack on the TV and the HDMI OUT jack of the corresponding Anynet+ device using an 
HDMI cable.

To connect to Home Theatre

�. Connect the HDMI IN (�, �, �(DVI) or �) jack on the TV and the HDMI OUT jack of the corresponding Anynet+ device using an 
HDMI cable.

�. Connect the HDMI IN jack of the home theatre and the HDMI OUT jack of the corresponding Anynet+ device using an HDMI 
cable.

Connect only one Home Theatre.
You can connect an Anynet+ device using the HDMI 1.3 cable. Some HDMI cables may not support Anynet+ functions.
Anynet+ works when the AV device supporting Anynet+ is in the Standby or On status.
Anynet+ supports up to 12 AV devices in total. Note that you can connect up to 3 devices of the same type.

¦

N
N
N
N

Anynet+ Device �

HDMI �.� Cable
HDMI �.� CableHDMI �.� CableHDMI �.� Cable

Anynet+ Device � Anynet+ Device � Anynet+ Device �
TV

Anynet+ Device �

HDMI �.� Cable

HDMI �.� Cable
HDMI �.� CableHDMI �.� Cable

Anynet+ Device � Anynet+ Device � Anynet+ Device �

TV

HDMI �.� Cable
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Setting Up Anynet+
Press the TOOLS button to display the Tools menu. You can also display Anynet+ menu 
by selecting Tools	→	Anynet+ (HDMI-CEC).

Setup

Anynet+ (HDMI-CEC)	→	Off	/	On
To use the Anynet+ Function, Anynet+ (HDMI-CEC) must be set to On.

When the Anynet+ (HDMI-CEC) function is disabled, all the Anynet+ related operations 
are deactivated.

Auto	Turn	Off	→	No	/	Yes
Setting an Anynet+ Device to turn Off automatically when the TV is turned Off.

The active source on the TV remote must be set to TV to use the Anynet+ function.
If you set Auto Turn Off to Yes, connected external devices are also turned off when the 
TV is turned off. If an external device is still recording, it may or may not turn off.

Switching between Anynet+ Devices

�. Press the TOOLS button. Press the ENTERE button to select Anynet+ (HDMI-CEC).
�. Press the ▲ or ▼ button to select Device List, then press the ENTERE button.

Anynet+ devices connected to the TV are listed.
If you cannot find a device you want, press the red button to scan for devices. 

�. Press the ▲ or ▼ button to select a particular device and press the ENTERE button. It 
is switched to the selected device.

Only when you set Anynet+ (HDMI-CEC) to On in the Application menu, the Device 
List menu appears.

Switching to the selected devices may take up to 2 minutes. You cannot cancel the 
operation during the switching operation.
The time required to scan for devices is determined by the number of connected devices.
When the device scan is complete, the number of devices found are not displayed.
Although the TV automatically searches the device list when the TV is turned on via the power button, devices connected to 
the TV may not always be automatically displayed in the device list. Press the red button to search for the connected device.
If you have selected external input mode by pressing the SOURCE button, you cannot use the Anynet+ function. Make sure to 
switch to an Anynet+ device by using the Device List.

Anynet+ Menu
The Anynet+ menu changes depending on the type and status of the Anynet+ devices connected to the TV.

Anynet+ Menu Description
View TV Anynet+ mode changes to TV broadcast mode.
Device List Shows the Anynet+ device list.

(device_name) Menu Shows the connected device menus. E.g. If a DVD recorder is connected, the disc 
menu of the DVD recorder will appear.

(device_name) INFO Shows the play menu of the connected device. E.g. If a DVD recorder is connected, 
the play menu of the DVD recorder will appear.

Recording: (*recorder) Starts recording immediately using the recorder. (This is only available for devices that 
support the recording function.)

Stop Recording: (*recorder) Stops recording.
Receiver Sound is played through the receiver.

If more than one recording device is connected, they are displayed as (*recorder) and if only one recording device is 
connected, it will be represented as (*device_name).

¦
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❑
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U	Move							E	Enter							R	Return

Anynet+	(HDMI-CEC)	 :	On																																		▶

Setup

Auto	Turn	Off	 :	Yes

Media	Play	(USB	&	DLNA)

Anynet+	(HDMI-CEC)	

Content	Library
Internet@TV	
Home	Network	Centre

Application

U	Move							E	Enter							R	Return

Anynet+	(HDMI-CEC)	 :	On

Setup

Auto	Turn	Off	 :	Yes																															▶

U	Move							E	Enter							R	Return

View	TV
Device	List
Recording:	DVDR
DVDR	MENU
DVDR	INFO
Setup
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TV Remote Control Buttons Available in Anynet+ Mode

Device Type Operating Status Available Buttons

Anynet+ Device

After switching to the device, when the 
menu of the corresponding device is 
displayed on the screen.

Numeric buttons
▲/▼/◄/►/ ENTERE buttons
Colour buttons / EXIT button

After switching to the device, while playing 
a file

π(Backward search) / μ(Forward search) / 
∫(Stop) / ∂(Play) / ∑(Pause)

Device with built-in 
Tuner

After switching to the device, when you 
are watching a TV program P > / P < button

Audio Device When Receiver is activated Volume / MUTE button

The Anynet+ function only works when the active source on the TV remote control is set to TV.
The ∏ button works only while in the recordable state.
You cannot control Anynet+ devices using the buttons on the TV. You can control Anynet+ devices only using the TV remote 
control.
The TV remote control may not work under certain conditions. If this occurs, reselect the Anynet+ device.
The Anynet+ functions do not operate with other manufacturers’ products.
The π, μ operations may differ depending on the device.

Recording
You can make a recording of a TV program using a Samsung recorder.
�. Press the TOOLS button. Press the ENTERE button to select Anynet+ (HDMI-CEC).
�. Press the ▲ or ▼ button to select Recording Immediately and press the ENTERE 

button. Recording begins.
When there is more than one recording device
When multiple recording devices are connected, the recording devices are listed. 
Press the ▲ or ▼ button to select a recording device and press the ENTERE 
button. Recording begins.
When the recording device is not displayed select Device List and press the Red 
button to search devices.

�. Press the EXIT button to exit.
You can record the source streams by selecting Recording: (device_name).
Pressing the ∏ button will record whatever you are currently watching. If you are watching video from another device, the 
video from the device is recorded.
Before recording, check whether the antenna jack is properly connected to the recording device. To properly connect an 
antenna to a recording device, refer to the recording device’s users manual.

Listening through a Receiver (Home theatre)
You can listen to sound through a receiver instead of the TV speaker.
�. Press the TOOLS button. Press the ENTERE button to select Anynet+ (HDMI-CEC).
�. Press the ▲ or ▼ button to select Recording Immediately and press the ENTERE 

button. Recording begins.
Press the ▲ or ▼ button to select Receiver. Press the ◄ or ► button to select On or Off.

�. Press the EXIT button to exit.
If your receiver supports audio only, it may not appear in the device list.
If there is a power interruption to the TV when the Receiver is set to On (by 
disconnecting the power cord or a power failure), the Speaker Select may be set to 
External Speaker when you turn the TV on again.

N
N
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U	Move							E	Enter							R	Return

View	TV
Device	List
Recording:	DVDR
DVDR	MENU
DVDR	INFO
Setup

U	Move							E	Enter							R	Return

View	TV
Device	List
Recording:	DVDR
DVDR	MENU
DVDR	INFO
Receiver:	Off
Setup
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Troubleshooting for Anynet+

Problem Possible Solution
Anynet+ does not work. Check if the device is an Anynet+ device. The Anynet+ system supports Anynet+ devices 

only.
Connect only one receiver (home theatre).
Check if the Anynet+ device power cord is properly connected.
Check the Anynet+ device’s Video/Audio/HDMI 1.3 cable connections.
Check whether Anynet+ (HDMI-CEC) is set to On in the Anynet+ setup menu.
Check whether the TV remote control is in TV mode.
Check whether it is Anynet+ exclusive remote control.
Anynet+ doesn’t work in certain situations. (Searching channels, Operating Media Play, 
Plug & Play, etc.)
When connecting or removing the HDMI 1.3 cable, please make sure to search devices 
again or turn your TV off and on again.
Check if the Anynet+ Function of Anynet+ device is set on.

●

●
●
●
●
●
●
●

●

●
I want to start Anynet+. Check if the Anynet+ device is properly connected to the TV and check if the Anynet+ 

(HDMI-CEC) is set to On in the Anynet+ Setup menu.
Press the TV button on the TV remote control to switch to TV. Then press the TOOLS button 
to show the Anynet+ menu and select a menu you want.

●

●

I want to exit Anynet+. Select View TV in the Anynet+ menu.
Press the SOURCE button on the TV remote control and select a device other than Anynet+ 
devices.
Press P >/<, PRE-CH, and FAV.CH to change the TV mode. (Note that the channel 
button operates only when a tuner-embedded Anynet+ device is not connected.)

●
●

●

The message 
‘Connecting to Anynet+ 
device...’ appears on the 
screen.

You cannot use the remote control when you are configuring Anynet+ or switching to a view 
mode.
Use the remote control when the Anynet+ setting or switching to view mode is complete.

●

●

The Anynet+ device does 
not play.

You cannot use the play function when Plug & Play is in progress.●

The connected device is 
not displayed.

Check whether or not the device supports Anynet+ functions.
Check whether or not the HDMI 1.3 cable is properly connected.
Check whether Anynet+ (HDMI-CEC) is set to On in the Anynet+ setup menu.
Search Anynet+ devices again.
You can connect an Anynet+ device using the HDMI 1.3 cable only. Some HDMI cables may 
not support Anynet+ functions.
If it is terminated by an abnormal situation such as disconnecting the HDMI cable or power 
cord or a power failure, please repeat the device scan.

●
●
●
●
●

●

The TV programme 
cannot be recorded.

Check whether the antenna jack on the recording device is properly connected.●

¦
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CONTENT LIBRARY

Using the Content Library
The Content Library allows you to enjoy various content on your TV. You can use the default 
content stored in the TV memory or you can enjoy new content using a USB device or via the 
Internet.

Using the Content Library Menu
�. Press the MENU button. Press the ▲ or ▼ button to select Application, then press the 

ENTERE button.
�. Press the ▲ or ▼ button to select Content Library, then press the ENTERE button.

The Content Library main menu is displayed.
�. Press the ◄ or ► button to select an icon (Gallery, Cooking, Game, Children, Wellness, 

Others, Content Management), then press the ENTERE button.

Using the Remote Control Button in Content Library Menu
Button Operations

▲/▼/◄/► Move the cursor and select an item.
ENTERE Select the currently selected item.
RETURN Return to the previous menu.

EXIT Stop the current function and return to the Content Library main menu.
P >/< Stop Content Library mode and Returns to TV mode.

Colour button Keys that provide functions are described on the corresponding page.
Y / MUTE You can control the volume of the played content.

CONTENTS LIBRARY CONTAINS TEXT, GRAPHICS, IMAGES, MULTIMEDIA, AND OTHER MATERIALS FOR 
INFORMATIONAL AND PROMOTIONAL PURPOSES ONLY. MATERIALS IN CONTENTS LIBRARY HAS BEEN MODIFIED 
AND KEEPS BEING REVISED AND UPDATED. THE MATERIALS IN THE CONTENTS LIBRARY MAY NOT BE SUITABLE 
FOR ALL AUDIENCES.
INFORMATION IN THE CONTENTS LIBRARY IS PROVIDED ‘AS IS.’ ALTHOUGH THE INFORMATION PROVIDED TO YOU 
IN THE CONTENTS LIBRARY IS OBTAINED OR COMPLIED FROM SOURCES WE BELIEVE TO BE RELIABLE, SAMSUNG 
CANNOT AND DOES NOT GUARANTEE THE ACCURACY, VALIDITY, TIMELINESS OR COMPLETENESS
OF ANY INFORMATION OR DATA MADE AVAILABLE TO YOU FOR ANY PARTICULAR PURPOSE. UNDER NO 
CIRCUMSTANCES, INCLUDING NEGLIGENCE, SHALL SAMSUNG BE HELD LIABLE, WHETHER IN CONTRACT OR TORT, 
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES, ATTORNEY FEES, EXPENSES, 
OR ANY OTHER DAMAGES WHATSOEVER ARISING OUT OF, OR IN CONNECTION WITH, ANY INFORMATION 
CONTAINED IN, OR THE USE OF, THE CONTENTS LIBRARY, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES.

¦

N

Media	Play	(USB	&	DLNA)
Anynet+	(HDMI-CEC)	

Content	Library

Internet@TV	
Home	Network	Centre

Application

R	Return									e	Exit

Gallery

Gallery Cooking Game Children Wellness
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Using the TV Memory Contents
You can use enjoy content stored in the TV memory. You can add/delete content to/from the TV 
memory. To add/delete content, select Content Management.

To return to Content Library main menu, press the EXIT button.

Gallery
This function plays a SlideShow with high resolution images and background music and 
produces various atmospheres. Using the Gallery function of the TV, you can change your home 
atmosphere.

The copyrights of the Gallery contents and all issues related to them are reserved by TimeSpace, Inc. 
Press the ENTERE button to pause the SlideShow, and also press the ENTERE button to resume the SlideShow.
Press the INFO button to display information on the selected photo. (This is not displayed if the photo has no information.)

Cooking
You can view various recipes and then easily follow them step by step. Enjoy these contents which will give you great ideas for 
meals.

The recipes introduced in the Cooking contents on the Samsung TV are based on recipes published by Anness Publishing.
The copyrights of the Cooking contents and all issues related to them are reserved by Practical Pictures.

Game
This category provides entertainment games for the whole family.

For the buttons used in the games, refer to the directions on the screen.
Colour Buttons for Games

Button Operations
Red Press to move to the game home screen

Green Press to pause the game
Yellow Option Key
Blue Press to exit the game

Children
This is educational and interactive content that children can watch repeatedly. 

The copyrights of the Children contents and issues related to them reserved by UpToTen.

Wellness
This is beneficial health management content (relaxing sound) that can be enjoyed by the whole family.

Others 
The default content is not saved in the TV memory.

You can copy new content to the TV memory using the Content Management screen.

¦
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Gallery Cooking Game Children Wellness
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Using the Content Management

Content Management
You can add or delete contents using the Content Management.

You can select multiple content items by selecting content items repeatedly and pressing 
the Yellow button.

My Contents
You can check the content saved in the TV memory for each subitem of the Content Library.

Select a content item and press the ENTERE button. You can play or delete the selected 
content item.

USB
You can check the content saved on the USB device for each subitem of the Content Library.

Select a content item and press the ENTERE button. You can play the selected content 
item or copy it to the TV memory.
Content Library only supports USB Mass Storage Class devices (MSC). MSC is a Mass 
Storage Class Bulk-Only Transport device. Examples of MSC are Thumb drives and Flash Card Readers.
Playing a game using an external USB memory device will allow you to save your game (depending on the game). Take care 
as removing the USB memory device while saving data to the USB memory device may cause the data to be lost.
Downloading New Contents
New content other than the built-in content will be provided via the Samsung.com website free of charge. When you download 
the paid contents, you need UDN number to download contents. Check the UDN number before downloading a new content 
item.

Downloading Content
�. Visit the www.samsung.com website.
�. Select a content item in the Contents Download page.
�. Download the contents onto the USB memory device.
�. Go to Content Library main menu by pressing CONTENT button or choosing Content Library (Menu → 

Application	→	Content	Library).
�. Plug the USB memory into USB port on the side of the TV.
�. You can see the content sub item which you downloaded.
�. Select a content item and press the enter button.
�. You can play the selected content item or copy it to the TV memory.

Setup
Screen Saver Run Time: Select to set the waiting time before the screen saver appears.
Save UDN: Saves the UDN number to a USB device.
An NTFS format USB storage device does not support saving UDN. We recommend using a FAT format USB storage device.

¦
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My	Contents

Internet	Download

USB

Setup

TV	Memory						
17.16GB/189.00MB	Available

Gallery

Cooking

Game

Children

Wellness

Others

Content	Management	>	My	Contents
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INTERNET@TV
This function may not be supported depending on your country.
If you have some problems while using a widget service, please contact to service provider.
In the widget, press the green button and get contact information or refer to help website for service provider information.
English may be only supported in widget service depending on region.

Getting Started with Internet@TV
Internet@TV provides SAMSUNG’s widget services through a network connection. Internet@TV contents can be changed 
depending on contents provider. You can access various information such as YouTube, through the Internet@TV service. 

The configuration of Widgets and their provided services may differ according to the selected country. After changing 
country, turn off and on the TV. Then you can use widget service supported changed country. If Country is set to Others, 
TV can’t recognize your country. In this case, please select directly from the service country list.
If a certain content’s font provided by contents provider is not supported on TV, It may not be viewed normally.
For more information on how how to configure your country, refer to the ‘Plug & Play Feature’ instructions. 
You may experience slow operation or hesitation when using this function due to network conditions.
Before using Internet@TV, set up the network first. For more information on how to configure your network, refer to 
‘Setting the Network’.

When running Internet@TV for the first time, the basic settings proceed automatically. It may take few minutes to update.
�. Press the MENU button. Press the ▲ or ▼ button to select Application, then press the ENTERE button.
�. Press the ▲ or ▼ button to select Internet@TV, then press the ENTERE button.

Press the Internet@ button on the remote control to display the Internet@TV menu.
�. The ‘User Agreement’ is displayed. Select Agree to accept the agreement.
�. The ‘Statistics & Analysis’ is displayed. Select Agree to accept the agreement.

Setting up Internet@TV
You can check and use the menus regarding Single Sign On (SSO), system management and properties. Press the ▲ or ▼ 
button to select Setup, then press the ENTERE button.

Single Sign On
You can use this menu when creating, deleting the account.
Using the Single Sign On, you can control your account including contents site’s account information.
You don’t need additional log in.

Account is only for internet@TV.

Create Account
You can create account and be linked with desired service site.

Account will be made less than 10.
Character of Account should be limited to 10.
If there is no service that needs log in, you can not create account.

Account Management
Service Site: You can register log in information of service site (such as YouTube).
Change Password: Change the password of your account.
Delete: Delete the account.

If you forget the password of account, press the remote control buttons in the following sequence, which resets the 
Internet@TV: POWER (off)	→	MUTE	→	9	→	4	→	8	→	POWER (on). 

If you use this function, all accounts will be deleted.
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System Setup
Ticker Autorun, Ticker Duration may not be supported depending on country.

Change the Service Lock password
The default password number of a new TV set is 0-0-0-0.
If you forget the password, press the remote control buttons in the following sequence, which resets the password to 0-0-
0-0: POWER (off) →	MUTE	→	8	→	2	→	4	→	POWER (on).

Service Duration
Select to set the service duration time before the screen saver appears.

Ticker	Autorun	→	Off	/	On
Select to set ticker to run automatically or not when turning on the TV.

Ticker Duration
Select to set the service duration time before the screen saver appears.

Properties
Display information of Internet@TV.
You can measure the speed of your Internet TV service using Measuring the speed of the Internet TV service.

Using the Internet@TV service
In a widget that provides multiple category menus, you can view the contents of the category menus using the ◄ and ► buttons.

Account Login
�. Press the Red button.
�. Select desired User account, then press the ENTERE button.
�. Input the password.

When login succeeds, User account will be displayed on the screen.
Before login, at least one and more account should be registered. If you want to create account, refer to ‘Setting up 
Internet@TV’.

Using the Widget Gallery
You can use Run Service, Lock, Install Service at the existing widget and you can see description of the widget service that isn’t 
installed.
On the Internet@TV, you can add and use various widgets provided by service provider. It may vary according to contents 
provider.

Run Service: Runs the widget service.
Lock: Set the service lock
Install Service (or Delete Service): Install or delete widget service.

Using the YouTube Widget
You can watch the movie provided by YouTube.
If you have the account in YouTube, Register account information using Account 
management. Then, you can use My Favourites category.

The menu can be changed by web service.
There may be inappropriate contents for child. In this case, use Lock function in 
Widget Gallery. 
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Most	Viewed
Top	Rated
Most	Popular
Most	Discussed
Top	Favourites
Most	Linked
Most	Respomded
Featured

'	Change	Mode			ll		rr  Change	page			U	Move  E	OK			R	Return

Today 1/7

Seeking	Justice	Decades	Later
Views	:	819,252																Rating	: 2009-02-07

0:01:30

Breaking	News	Alerts	by	E-Mail
Views	:	819,252																Rating	: 2009-02-07

0:00:45

The	world	reacts	to	U.S.	bailout	plan
Views	:	819,252																Rating	: 2009-02-07

0:01:30

Boo	Hoo	in	the	Boardroom
Views	:	819,252																Rating	: 2009-02-07

0:03:26
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Troubleshooting for internet@TV

Problem Possible Solution
Some widget services do not work. Check with that service provider.

In the widget, press the green button and get contact information or refer to help 
website for widget service provider information.
Refer to Help website page.

What is the advantage of single sign 
on?

If you create account and register your login information of desired service, you can 
access personalized content without additional login.

When a network error occurred, I can’t 
use other menus except setting menu.

If network connection doesn’t work, your service might be limited.
Because all of function except setting menu are needed to connect internet.

Is there any possibility to show adult 
movies on YouTube?

Basically, at the list on the menu it is filtered out. But by using search function, It can 
be shown. In this case, using the Widget Gallery lock the widget service.

Help Website

Country Website
UAE www.samsung.com → Consumer → television → medi@2.0 → Internet@TV

Australia www.samsung.com → Consumer → television → medi@2.0 → Internet@TV

China www.samsung.com → 个人消费产品 → 电视产品 → medi@2.0 → Internet@TV

India www.samsung.com → consumer products → television → medi@2.0 → Internet@TV

Indonesia www.samsung.com → Produk → television → medi@2.0 → Internet@TV

Japan www.samsung.com → 製品情報 → 液晶ディスプレイ → medi@2.0 → Internet@TV

Malaysia www.samsung.com →Consumer → television → medi@2.0 → Internet@TV

NewZealand www.samsung.com → Consumer → television → medi@2.0 → Internet@TV

Philippines www.samsung.com → Consumer → television → medi@2.0 → Internet@TV

Singapore www.samsung.com → Consumer → television → medi@2.0 → Internet@TV

Taiwan www.samsung.com → 個人消費産品 → 電視 → medi@2.0 → Internet@TV

Thailand www.samsung.com → ผลิตภัณฑ์ → โทรทัศน์ → medi@2.0 → Internet@TV

Vietnam www.samsung.com → sản phẩm nghe nhìn → máy thu hình → medi@2.0 → Internet@TV

South Africa www.samsung.com → Consumer → television → medi@2.0 → Internet@TV

Approaching step may be changed later on.
It can be different links for special countries.
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HOME NETWORK CENTRE

Home Network Centre
About the Home Network Centre
The Home Network Centre connects the TV and mobile phones through a network. You can view call arrivals, text message 
contents, and schedules set on the mobile phone on the TV using the Home Network Centre. In addition, you can play the media 
contents saved on the mobile phones such as videos, photos and music by importing them onto the TV via the network.

If the device supports DLNA DMC (Digital Media Controller) function, Home Network Centre function is available.
The Samsung SCH-i�00 mobile phone supports the Home Network Centre. Other models will be added in the future.
The mobile device may need additional software installation. For details, refer to each user’s guide.
To play media contents on the TV, you need a mobile phone or PDA(Personal Digital Assistant) that supports the DLNA DMC 
(Digital Media Controller) function

Connecting to the Home Network Centre 
For more information about the network settings, refer to page 21.

Connecting to a WLAN Ad-hoc network
�. Connect the ‘Samsung Wireless LAN Adapter’ to the USB�(HDD) or USB� port of the TV.

�. For more information on how to configure Ad-hoc network, refer to page 26.
For information on configuring the mobile phone’s network settings, refer to the mobile phone manual.

�. Set up the IP address, SSID and password for the mobile phone in the Ad-hoc Settings of the mobile phone using the Network 
Name (SSID) and Security Key (password) displayed on the TV.
Connecting through a Wireless IP sharer

�. Connect the LAN port of the TV and the Wireless IP sharer using the LAN cable.
Although the LAN port is connected, the network settings are configured for the wireless network.

For the procedures to set up the wireless sharer and the mobile phone, refer to the manual of the corresponding device.
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Setting Up the Home Network Centre

Message 
Shows a list of mobile phones which have been set up with this TV to use the 
message function (the call arrivals, text message contents and schedules set on the 
mobile phone).

Allowed
Allows the mobile phone.

Denied
Blocks the mobile phone.

Delete
Deletes the mobile phone from the list.

This function just deletes the name from the list. If the deleted mobile device turns on or tries to connect to the TV, it may be 
shown on the list.

Media 
Shows a list of mobile phones which is available to control media contents (videos, 
photos, music) from the phone.

Besides mobile phone, other mobile devices that support DLNA DMC are available.

Allowed
Allows the mobile phone.

Denied
Blocks the mobile phone.

Delete
Deletes the mobile phone from the list.

This function just deletes the corresponding name on the list. If the deleted mobile device turns on or tries to connect to the 
TV, it may be shown on the list.

Setup

Message	→	On	/	Off
You can determine whether to use the message function (the call arrivals, text message 
contents, and schedules set on the mobile phone).

Media	→	On	/	Off
You can select whether to use the play function that plays the contents (videos, photos, 
music) from the mobile phone. 

TV name
You can set the TV name so as to find it easily on the mobile device.

If you selects User Input, you can type the TV name by OSK(On Screen Keyboard).
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Using the Message Function
Using this function, you can view the call arrivals, text message contents and schedules 
set on the mobile phone through the alarm window while watching TV. 

To disable this Message alarm window, set Message to Off in Setup of the Home 
Network Centre.
The alarm window appears for 20 seconds. If no key is pressed or if Cancel is 
selected, it appears up to three times at 5 minute intervals.
If OK is selected, or if OK is not selected while the message is displayed three 
times, the message will be deleted. The message is not deleted from the mobile 
phone. 
The simple alarm window can be displayed, while using some applications such 
as Media Play, Content Library, etc. In this case, to view the contents of the 
message, switch to TV viewing mode.
When the message of an unknown mobile phone is displayed, select the mobile 
phone in the Message item of the Home Network Centre and select Denied to 
block the phone.

Message View
If a new test message (SMS) arrives while you are watching TV, the alarm window 
appears. If you click the OK button, the contents of the message are displayed.

If you select the OK button, the contents of the message are displayed.
If you select the Cancel button, the alarm window appears up to three times at 5 
minute intervals.
You can configure the viewing settings for the text message (SMS) contents on the 
mobile phone. For the procedures, refer to the mobile phone manual.
Some special characters may be displayed as blank or broken characters.

Call Arrival Alarm
If a call arrives while you are watching TV, the alarm window appears.

If you select the OK button, the call arrival alarm is confirmed and the alarm 
window is closed.
If you select the Cancel button, the alarm window appears up to three times at 5 
minute intervals.

Schedule Alarm
While you are watching TV, the alarm window appears to display the registered 
schedule.

If you select the OK button, you can view the contents of the schedule registered 
on the mobile phone.
If you select the Cancel button, the alarm window appears up to three times at 5 
minute intervals.
You can configure the viewing settings for the schedule contents on the mobile 
phone. For the procedures, refer to the mobile phone manual.
Some special characters may be displayed as blank or broken characters.
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Using the Media Function
An alarm window appears informing the user that the media contents (videos, photos, music) sent from the mobile phone will be 
displayed on the TV.
The contents are played automatically 3 seconds after the alarm window appears.
If you press the RETURN or EXIT button when the alarm window appears, the Media Contents are not played.

To turn off the media contents transmission from the mobile phone, set Media to Off in Setup of the Home Network Centre.
The contents may not be played on the TV depending on their resolution and format.

Media play control buttons
Button Operations

◄/► Move the cursor and select an item.
While playing a movie file: Move forwards or backwards through the movie file in 10 second interval.

ENTERE
Pressing the ENTERE button during play pauses the play.
Pressing the ENTERE button during pause resumes the play.

RETURN Return to the previous menu.
TOOLS Run various functions from the Photo, Music and Movie menus.
INFO Show file information.
EXIT Stop Media Play mode and Returns to TV mode.

The ENTERE and ◄/► buttons may not work depending on the type of media content.
Using the mobile device, you can control playing media. For details, refer to each user’s guide.

¦

N
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N
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RECOMMENDATIONS

Teletext Feature
Most television stations provide written information services via Teletext. The index page of the Teletext service gives you 
information on how to use the service. In addition, you can select various options to suit your requirements by using the remote 
control buttons.

For Teletext information to be displayed correctly, channel reception must be stable. Otherwise, information may be missing or 
some pages may not be displayed.

1 : (exit)
Exit from the Teletext display.

2 8 (store)
Used to store the Teletext pages.

3 4 (size)
Press to display the double-size letters in the upper half of the screen. For lower half 
of the screen, press it again. To display normal screen, press it once again.

4 6 (index)
Used to display the index (contents) page at any time while you are viewing Teletext.

5 Colour buttons (red/green/yellow/blue)
If the FASTEXT system is used by a broadcasting company, the different topics 
covered on a Teletext page are colour-coded and can be selected by pressing 
the coloured buttons. Press one of them corresponding to the required. The page 
is displayed with other coloured information that can be selected in the same 
way. To display the previous or next page, press the corresponding coloured 
button.

6 / (Teletext on/mix)
Press to activate Teletext mode after selecting the channel providing the Teletext 
service. Press it twice to overlap the Teletext with the current broadcasting screen.

7 5 (reveal)
Used to display the hidden text (answers to quiz games, for example). To display 
normal screen, press it again.

8 1 (sub-page)
Used to display the available sub-page.

9 9 (hold)
Used to hold the display on a given page if the selected page is linked with several 
secondary pages which follow on automatically. To resume, press it again.

0 7 (cancel)
Used to display the broadcast when searching for a page.

! 2 (page up)
Used to display the next Teletext page.

@ 3 (page down)
Used to display the previous Teletext page.

# 0 (mode)
Press to select the Teletext mode (LIST/ FLOF). If you press it in the LIST mode, it 
switches into the List save mode. In the List save mode, you can save Teletext page 
into list using the 8(store) button.

You can change Teletext pages by pressing the numeric buttons on the remote control. 
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The Teletext pages are organized according to six categories:

Part Contents
A Selected page number.
B Broadcasting channel identity.
C Current page number or search indications.
D Date and time.
E Text.
F Status information.

FASTEXT information.

Teletext information is often divided between several pages displayed in sequence, which can be accessed by:
Entering the page number
Selecting a title in a list
Selecting a coloured heading (FASTEXT system)

Teletext level supported by the TV is version 2.5 which is capable of displaying additional graphics or text.
Depending upon the transmission, blank side panels can occur when displaying Teletext.
In these cases, additional graphics or text is not transmitted.
Older TV’s which do not support version 2.5 are not capable of displaying any additional graphics or text, regardless of the 
Teletext transmission.
Press the TV button to exit from the Teletext display.

Installing the Stand

�. Attach your LCD TV to the stand.
Two or more people should carry the TV.
Make sure to distinguish between the front and back of the stand when assembling 
them.
To make sure the TV is installed on the stand at a proper level, do not apply excess 
downward pressure to the upper left of right sides of the TV.

�. Fasten screws at position 1 and then fasten screws at position 2.
Stand the product up and fasten the screws. If you fasten the screws with the LCD TV 
placed down, it may lean to one side.

N
N

N

N

2

1

Disconnecting the Stand

�. Remove four screws from the back of the TV.
�. Separate the stand from the TV.

Two or more people should carry the TV.
�. Cover the bottom hole with the cover.

N
�
�
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Installing the Wall Mount Kit

Wall mount items (sold separately) allow you to mount the TV on the wall.
For detailed information on installing the wall mount, see the instructions provided with the 
Wall Mount items. Contact a technician for assistance when installing the wall mounted 
bracket.
Samsung Electronics is not responsible for any damage to the product or injury to yourself or 
others if you elect to install the TV on your own.

Do not install your Wall Mount Kit while your TV is turned on. It may result in personal 
injury due to electric shock.

Remove the stand and cover the bottom hole with a cap and fasten with two screws.N

Assembling the Cables

Enclose the cables in the Holder-Wire Cable so that the cables are not visible through the 
transparent stand.

Anti-Theft Kensington Lock

The Kensington Lock is a device used to physically fix the system when using it in a public 
place. The appearance and locking method may differ from the illustration depending on the 
manufacturer.
Refer to the manual provided with the Kensington Lock for proper use. 

The locking device has to be purchased separately.
The location of the Kensington Lock may be different depending on its model.

�. Insert the locking device into the Kensington slot on the LCD TV (1) and turn it in the 
locking direction (2).

�. Connect the Kensington Lock cable (3).
�. Fix the Kensington Lock to a desk or a heavy stationary object.

N
N
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Securing the TV to the Wall

Caution: Pulling, pushing, or climbing on the TV may cause the TV to fall. In particular, ensure your 
children do not hang over or destabilize the TV; doing so may cause the TV to tip over, causing serious 
injuries or death. Follow all safety precautions provided on the included Safety Flyer. For added stability, 
install the anti-fall device for safety purposes, as follows.

To avoid the TV from falling:
�. Put the screws into the clamps and firmly fasten them onto the wall. Confirm that the 

screws have been firmly installed onto the wall.
You may need additional material such as an anchor depending on the type of 
wall.
Since the necessary clamps, screws, and string are not supplied, please 
purchase these additionally.

�. Remove the screws from the centre back of the TV, put the screws into the clamps, 
and then fasten the screws onto the TV again.

Screws may not be supplied with the product. In this case, please purchase the 
screws of the following specifications. 
Screw Specifications
For a 17 ~ 29 Inch LCD TV: M4 X 15 / For a 32 ~ 40 Inch LCD TV: M6 X 15

�. Connect the clamps fixed onto the TV and the clamps fixed onto the wall with a strong 
string and then tie the string tightly.

Install the TV near to the wall so that it does not fall backwards.
It is safe to connect the string so that the clamps fixed on the wall are equal to or 
lower than the clamps fixed on the TV.
Untie the string before moving the TV.

�. Verify all connections are properly secured. Periodically check connections for any 
sign of fatigue for failure. If you have any doubt about the security of your connections, 
contact a professional installer.
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Troubleshooting: Before Contacting Service Personnel
Before contacting service personnel

Problem Possible Solution

No sound or picture Check that the mains lead has been connected to a wall socket.
Check that you have pressed the button on your set.
Check the picture contrast and brightness settings.
Check the volume.

Normal picture but no sound Check the volume.
Check whether the MUTEM button has been pressed on the remote control.
Check the Speaker Select settings.

Screen is black and power 
indicator light blinks steadily

On your computer check; Power, Signal Cable.
The TV is using its power management system.
Move the computer’s mouse or press any key on the keyboard.

No picture or black and white 
picture

Adjust the colour settings.
Check that the broadcast system selected is correct.

Sound and picture interference Try to identify the electrical appliance that is affecting the set and move it further away.
Plug your set into a different mains socket.

Blurred or snowy picture, 
distorted sound

Check the direction, location and connections of your aerial.
This interference is often due to the use of an indoor aerial.

Remote control malfunctions Replace the remote control batteries.
Clean the upper edge of the remote control (transmission window).
Check the battery terminals.

‘Check signal cable.’ message is 
displayed

Check that the signal cable is fi rmly connected to the PC or video sources.
Check that the PC or video sources are turned on.

On PC mode, ‘Not Supported 
Mode.’ message is displayed

Check the maximum resolution and the frequency of the video adaptor.
Compare these values with the data in the Display Modes.

The damaged picture appears in 
the corner of the screen

If Screen Fit is selected in some external devices, the damaged picture may appear in the corner of the 
screen. This symptom is caused by external devices, not TV.

The ‘Resets all settings to 
the default values.’ message 
appears.

This appears when you press and hold the EXIT button for a while. The product settings are reset to the 
factory defaults.

You may see small particles if 
you look closely at the edge of 
the bezel surrounding the TV 
screen.

This is part of the product’s design and is not a defect.

This TFT LCD panel uses a panel consisting of sub pixels (6 220 800) which require sophisticated technology to produce. 
However, there may be few bright or dark pixels on the screen. These pixels will have no impact on the performance of the 
product.

¦
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Specifications

Model Name LA�0B��0 LA��B��0
Screen Size
(Diagonal) 40 inch 46 inch
PC Resolution
(Optimum) 1920 x 1080 @ 60 Hz 1920 x 1080 @ 60 Hz
Sound
(Output) 10W x 2 10W x 2
Dimensions (WxDxH)
Without Stand
With stand

984 X 79 X 629 mm
984 X 255 X 692 mm

1115 x 79 x 703 mm
1115 x 275 x 770 mm

Weight
With Stand 18 Kg 25 kg
Environmental Considerations
Operating Temperature
Operating Humidity
Storage Temperature
Storage Humidity

10°C to 40°C (50°F to 104°F)
10% to 80%, non-condensing
-20°C to 45°C (-4°F to 113°F)
5% to 95%, non-condensing

Stand Swivel
(Left / Right) -20˚ ~ 20˚

Model Name LA��B��0
Screen Size 
(Diagonal) 52 inch
PC Resolution
(Optimum) 1920 x 1080 @ 60 Hz
Sound
(Output) 10W x 2
Dimensions (WxDxH)
Without Stand
With stand

1258 x 80 x 795 mm
1258 x 305 x 859 mm

Weight
With Stand 30 kg
Environmental Considerations
Operating Temperature
Operating Humidity
Storage Temperature
Storage Humidity

10°C to 40°C (50°F to 104°F)
10% to 80%, non-condensing
-20°C to 45°C (-4°F to 113°F)
5% to 95%, non-condensing

Stand Swivel
(Left / Right) -20˚ ~ 20˚

Design and specifications are subject to change without prior notice.
This device is a Class B digital apparatus.
For the power supply and Power Consumption, refer to the label attached to the product.

¦
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This product uses parts of the software from the Independent JPEG Group.
This product uses parts of the software owned by the Freetype Project (www.freetype.org).
This product uses some software programs which are distributed under the GPL/LGPL license. Accordingly, the following 
GPL and LGPL software source codes that have been used in this product can be provided after asking to vdswmanager@
samsung.com.
GPL software: Linux Kernel, Busybox, Binutils
LGPL software: Glibc, ffmpeg, smpeg, libgphoto, libusb, SDL

GNU GENERAL PUBLIC LICENSE
Version �, �� June �00�
 Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>
 Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

Preamble

The GNU General Public License is a free, copyleft license for software and other kinds of works.

The licenses for most software and other practical works are designed to take away your freedom to share and change the 
works. By contrast, the GNU General Public License is intended to guarantee your freedom to share and change all versions 
of a program--to make sure it remains free software for all its users. We, the Free Software Foundation, use the GNU General 
Public License for most of our software; it applies also to any other work released this way by its authors. You can apply it to your 
programs, too.
When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to make sure 
that you have the freedom to distribute copies of free software (and charge for them if you wish), that you receive source code or 
can get it if you want it, that you can change the software or use pieces of it in new free programs, and that you know you can do 
these things.
To protect your rights, we need to prevent others from denying you these rights or asking you to surrender the rights. Therefore, 
you have certain responsibilities if you distribute copies of the software, or if you modify it: responsibilities to respect the freedom of 
others.
For example, if you distribute copies of such a program, whether gratis or for a fee, you must pass on to the recipients the same
freedoms that you received. You must make sure that they, too, receive or can get the source code. And you must show them 
these terms so they know their rights.
Developers that use the GNU GPL protect your rights with two steps: (1) assert copyright on the software, and (2) offer you this 
License giving you legal permission to copy, distribute and/or modify it.
For the developers’ and authors’ protection, the GPL clearly explains that there is no warranty for this free software. For both users’ 
and authors’ sake, the GPL requires that modified versions be marked as changed, so that their problems will not be attributed 
erroneously to authors of previous versions.
Some devices are designed to deny users access to install or run modified versions of the software inside them, although the 
manufacturer can do so. This is fundamentally incompatible with the aim of protecting users’ freedom to change the software. 
The systematic pattern of such abuse occurs in the area of products for individuals to use, which is precisely where it is most 
unacceptable. Therefore, we have designed this version of the GPL to prohibit the practice for those products. If such problems 
arise substantially in other domains, we stand ready to extend this provision to those domains in future versions of the GPL, as 
needed to protect the freedom of users.
Finally, every program is threatened constantly by software patents. States should not allow patents to restrict development and 
use of software on general-purpose computers, but in those that do, we wish to avoid the special danger that patents applied to 
a free program could make it effectively proprietary. To prevent this, the GPL assures that patents cannot be used to render the 
program non-free.
The precise terms and conditions for copying, distribution and modification follow.

TERMS AND CONDITIONS
0.  Definitions.

“This License” refers to version 3 of the GNU General Public License.
“Copyright” also means copyright-like laws that apply to other kinds of works, such as semiconductor masks.
“The Program” refers to any copyrightable work licensed under this License. Each licensee is addressed as “you”. “Licensees” 
and “recipients” may be individuals or organizations.
To “modify” a work means to copy from or adapt all or part of the work in a fashion requiring copyright permission, other than 
the making of an exact copy. The resulting work is called a “modified version” of the earlier work or a work “based on” the 
earlier work.

●
●
●

¦
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A “covered work” means either the unmodified Program or a work based on the Program.
To “propagate” a work means to do anything with it that, without permission, would make you directly or secondarily liable 
for infringement under applicable copyright law, except executing it on a computer or modifying a private copy. Propagation 
includes copying, distribution (with or without modification), making available to the public, and in some countries other 
activities as well.
To “convey” a work means any kind of propagation that enables other parties to make or receive copies. Mere interaction with 
a user through a computer network, with no transfer of a copy, is not conveying.
An interactive user interface displays “Appropriate Legal Notices” to the extent that it includes a convenient and prominently 
visible feature that (1) displays an appropriate copyright notice, and (2) tells the user that there is no warranty for the work 
(except to the extent that warranties are provided), that licensees may convey the work under this License, and how to view a 
copy of this License. If the interface presents a list of user commands or options, such as a menu, a prominent item in the list 
meets this criterion.

�. Source Code.
The “source code” for a work means the preferred form of the work for making modifications to it. “Object code” means any 
non-source
form of a work.
A “Standard Interface” means an interface that either is an official standard defined by a recognized standards body, or, in the 
case of interfaces specified for a particular programming language, one that is widely used among developers working in that 
language.
The “System Libraries” of an executable work include anything, other than the work as a whole, that (a) is included in the 
normal form of packaging a Major Component, but which is not part of that Major Component, and (b) serves only to enable 
use of the work with that Major Component, or to implement a Standard Interface for which an implementation is available to 
the public in source code form. A “Major Component”, in this context, means a major essential component (kernel, window 
system, and so on) of the specific operating system (if any) on which the executable work runs, or a compiler used to produce 
the work, or an object code interpreter used to run it.
The “Corresponding Source” for a work in object code form means all the source code needed to generate, install, and (for an 
executable work) run the object code and to modify the work, including scripts to control those activities. However, it does not 
include the work’s System Libraries, or general-purpose tools or generally available free programs which are used unmodified 
in performing those activities but which are not part of the work. For example, Corresponding Source includes interface 
definition files associated with source files for the work, and the source code for shared libraries and dynamically linked 
subprograms that the work is specifically designed to require, such as by intimate data communication or control flow between 
those subprograms and other parts of the work.
The Corresponding Source need not include anything that users can regenerate automatically from other parts of the 
Corresponding Source.
The Corresponding Source for a work in source code form is that same work.

�. Basic Permissions.
All rights granted under this License are granted for the term of copyright on the Program, and are irrevocable provided the 
stated conditions are met. This License explicitly affirms your unlimited permission to run the unmodified Program. The output 
from running a covered work is covered by this License only if the output, given its content, constitutes a covered work. 
This License acknowledges your rights of fair use or other equivalent, as provided by copyright law. You may make, run and 
propagate covered works that you do not convey, without conditions so long as your license otherwise remains in force. You 
may convey covered works to others for the sole purpose of having them make modifications exclusively for you, or provide 
you with facilities for running those works, provided that you comply with the terms of this License in conveying all material 
for which you do not control copyright. Those thus making or running the covered works for you must do so exclusively on 
your behalf, under your direction and control, on terms that prohibit them from making any copies of your copyrighted material 
outside their relationship with you.
Conveying under any other circumstances is permitted solely under the conditions stated below. Sublicensing is not allowed; 
section 10 makes it unnecessary.

�. Protecting Users’ Legal Rights From Anti-Circumvention Law.
No covered work shall be deemed part of an effective technological measure under any applicable law fulfilling obligations 
under article 11 of the WIPO copyright treaty adopted on 20 December 1996, or similar laws prohibiting or restricting 
circumvention of such measures.
When you convey a covered work, you waive any legal power to forbid circumvention of technological measures to the extent 
such circumvention is effected by exercising rights under this License with respect to the covered work, and you disclaim any 
intention to limit operation or modification of the work as a means of enforcing, against the work’s users, your or third parties’ 
legal rights to forbid circumvention of technological measures.

�. Conveying Verbatim Copies.
You may convey verbatim copies of the Program’s source code as you receive it, in any medium, provided that you 
conspicuously and appropriately publish on each copy an appropriate copyright notice; keep intact all notices stating that this 
License and any non-permissive terms added in accord with section 7 apply to the code; keep intact all notices of the absence 
of any warranty; and give all recipients a copy of this License along with the Program.
You may charge any price or no price for each copy that you convey, and you may offer support or warranty protection for a 
fee.

�. Conveying Modified Source Versions.
You may convey a work based on the Program, or the modifications to produce it from the Program, in the form of source code 
under the terms of section 4, provided that you also meet all of these conditions:
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a) The work must carry prominent notices stating that you modified it, and giving a relevant date.
b) The work must carry prominent notices stating that it is released under this License and any conditions added under 
section 7. This requirement modifies the requirement in section 4 to “keep intact all notices”.
c) You must license the entire work, as a whole, under this License to anyone who comes into possession of a copy. This 
License will therefore apply, along with any applicable section 7 additional terms, to the whole of the work, and all its 
parts, regardless of how they are packaged. This License gives no permission to license the work in any other way, but it 
does not invalidate such permission if you have separately received it.
d) If the work has interactive user interfaces, each must display Appropriate Legal Notices; however, if the Program has 
interactive interfaces that do not display Appropriate Legal Notices, your work need not make them do so.

A compilation of a covered work with other separate and independent works, which are not by their nature extensions of 
the covered work, and which are not combined with it such as to form a larger program, in or on a volume of a storage or 
distribution medium, is called an “aggregate” if the compilation and its resulting copyright are not used to limit the access or 
legal rights of the compilation’s users beyond what the individual works permit. Inclusion of a covered work in an aggregate 
does not cause this License to apply to the other parts of the aggregate.

�. Conveying Non-Source Forms.
You may convey a covered work in object code form under the terms of sections 4 and 5, provided that you also convey the 
machine-readable Corresponding Source under the terms of this License, in one of these ways:

a) Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied 
by the Corresponding Source fixed on a durable physical medium customarily used for software interchange.
b) Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied 
by a written offer, valid for at least three years and valid for as long as you offer spare parts or customer support for that 
product model, to give anyone who possesses the object code either (1) a copy of the Corresponding Source for all the 
software in the product that is covered by this License, on a durable physical medium customarily used for software 
interchange, for a price no more than your reasonable cost of physically performing this conveying of source, or (2) 
access to copy the Corresponding Source from a network server at no charge.
c) Convey individual copies of the object code with a copy of the written offer to provide the Corresponding Source. This 
alternative is allowed only occasionally and noncommercially, and only if you received the object code with such an offer, 
in accord with subsection 6b.
d) Convey the object code by offering access from a designated place (gratis or for a charge), and offer equivalent 
access to the Corresponding Source in the same way through the same place at no further charge. You need not require 
recipients to copy the Corresponding Source along with the object code. If the place to copy the object code is a network 
server, the Corresponding Source may be on a different server (operated by you or a third party) that supports equivalent 
copying facilities, provided you maintain clear directions next to the object code saying where to find the Corresponding 
Source. Regardless of what server hosts the Corresponding Source, you remain obligated to ensure that it is available for 
as long as needed to satisfy these requirements.
e) Convey the object code using peer-to-peer transmission, provided you inform other peers where the object code and 
Corresponding Source of the work are being offered to the general public at no charge under subsection 6d. A separable 
portion of the object code, whose source code is excluded from the Corresponding Source as a System Library, need not 
be included in conveying the object code work.

A “User Product” is either (1) a “consumer product”, which means any tangible personal property which is normally used for 
personal, family, or household purposes, or (2) anything designed or sold for incorporation into a dwelling. In determining 
whether a product is a consumer product, doubtful cases shall be resolved in favor of coverage. For a particular product 
received by a particular user, “normally used” refers to a typical or common use of that class of product, regardless of the 
status of the particular user or of the way in which the particular user actually uses, or expects or is expected to use, the 
product. A product is a consumer product regardless of whether the product has substantial commercial, industrial or non-
consumer uses, unless such uses represent the only significant mode of use of the product.
“Installation Information” for a User Product means any methods, procedures, authorization keys, or other information required 
to install and execute modified versions of a covered work in that User Product from a modified version of its Corresponding 
Source. The information must suffice to ensure that the continued functioning of the modified object code is in no case 
prevented or interfered with solely because modification has been made.
If you convey an object code work under this section in, or with, or specifically for use in, a User Product, and the conveying 
occurs as part of a transaction in which the right of possession and use of the User Product is transferred to the recipient in 
perpetuity or for a fixed term (regardless of how the transaction is characterized), the Corresponding Source conveyed under 
this section must be accompanied by the Installation Information. But this requirement does not apply if neither you nor any 
third party retains the ability to install modified object code on the User Product (for example, the work has been installed in 
ROM).

�
�

�
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The requirement to provide Installation Information does not include a requirement to continue to provide support service, 
warranty, or updates for a work that has been modified or installed by the recipient, or for the User Product in which it has 
been modified or installed. Access to a network may be denied when the modification itself materially and adversely affects the 
operation of the network or violates the rules and protocols for communication across the network.
Corresponding Source conveyed, and Installation Information provided, in accord with this section must be in a format that is 
publicly documented (and with an implementation available to the public in source code form), and must require no special 
password or key for unpacking, reading or copying.

�. Additional Terms.
“Additional permissions” are terms that supplement the terms of this License by making exceptions from one or more of its 
conditions. Additional permissions that are applicable to the entire Program shall be treated as though they were included in 
this License, to the extent that they are valid under applicable law. If additional permissions apply only to part of the Program, 
that part may be used separately under those permissions, but the entire Program remains governed by this License without 
regard to the additional permissions.
When you convey a copy of a covered work, you may at your option remove any additional permissions from that copy, or 
from any part of it. (Additional permissions may be written to require their own removal in certain cases when you modify the 
work.) You may place additional permissions on material, added by you to a covered work, for which you have or can give 
appropriate copyright permission.
Notwithstanding any other provision of this License, for material you add to a covered work, you may (if authorized by the 
copyright holders of that material) supplement the terms of this License with terms:

a) Disclaiming warranty or limiting liability differently from the terms of sections 15 and 16 of this License; or
b) Requiring preservation of specified reasonable legal notices or author attributions in that material or in the Appropriate 
Legal Notices displayed by works containing it; or
c) Prohibiting misrepresentation of the origin of that material, or requiring that modified versions of such material be 
marked in reasonable ways as different from the original version; or
d) Limiting the use for publicity purposes of names of licensors or authors of the material; or
e) Declining to grant rights under trademark law for use of some trade names, trademarks, or service marks; or
f) Requiring indemnification of licensors and authors of that material by anyone who conveys the material (or modified 
versions of it) with contractual assumptions of liability to the recipient, for any liability that these contractual assumptions 
directly impose on those licensors and authors.

All other non-permissive additional terms are considered “further restrictions” within the meaning of section 10. If the Program 
as you received it, or any part of it, contains a notice stating that it is governed by this License along with a term that is a 
further restriction, you may remove that term. If a license document contains a further restriction but permits relicensing or 
conveying under this License, you may add to a covered work material governed by the terms of that license document, 
provided that the further restriction does not survive such relicensing or conveying.
If you add terms to a covered work in accord with this section, you must place, in the relevant source files, a statement of the 
additional terms that apply to those files, or a notice indicating where to find the applicable terms.
Additional terms, permissive or non-permissive, may be stated in the form of a separately written license, or stated as 
exceptions; the above requirements apply either way. 

�. Termination.
You may not propagate or modify a covered work except as expressly provided under this License. Any attempt otherwise to 
propagate or modify it is void, and will automatically terminate your rights under this License (including any patent licenses 
granted under the third paragraph of section 11).
However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated (a) 
provisionally, unless and until the copyright holder explicitly and finally terminates your license, and (b) permanently, if the 
copyright holder fails to notify you of the violation by some reasonable means prior to 60 days after the cessation.
Moreover, your license from a particular copyright holder is reinstated permanently if the copyright holder notifies you of the 
violation by some reasonable means, this is the first time you have received notice of violation of this License (for any work) 
from that copyright holder, and you cure the violation prior to 30 days after your receipt of the notice.
Termination of your rights under this section does not terminate the licenses of parties who have received copies or rights from 
you under this License. If your rights have been terminated and not permanently reinstated, you do not qualify to receive new 
licenses for the same material under section 10.

�. Acceptance Not Required for Having Copies.
You are not required to accept this License in order to receive or run a copy of the Program. Ancillary propagation of a covered 
work occurring solely as a consequence of using peer-to-peer transmission to receive a copy likewise does not require 
acceptance. However, nothing other than this License grants you permission to propagate or modify any covered work. These 
actions infringe copyright if you do not accept this License. Therefore, by modifying or propagating a covered work, you 
indicate your acceptance of this License to do so.

�
�

�
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�0. Automatic Licensing of Downstream Recipients.
Each time you convey a covered work, the recipient automatically receives a license from the original licensors, to run, modify 
and propagate that work, subject to this License. You are not responsible for enforcing compliance by third parties with this 
License.
An “entity transaction” is a transaction transferring control of an organization, or substantially all assets of one, or subdividing 
an organization, or merging organizations. If propagation of a covered work results from an entity transaction, each party 
to that transaction who receives a copy of the work also receives whatever licenses to the work the party’s predecessor in 
interest had or could give under the previous paragraph, plus a right to possession of the Corresponding Source of the work 
from the predecessor in interest, if the predecessor has it or can get it with reasonable efforts.
You may not impose any further restrictions on the exercise of the rights granted or affirmed under this License. For example, 
you may not impose a license fee, royalty, or other charge for exercise of rights granted under this License, and you may not 
initiate litigation (including a cross-claim or counterclaim in a lawsuit) alleging that any patent claim is infringed by making, 
using, selling, offering for sale, or importing the Program or any portion of it.

��. Patents.
A “contributor” is a copyright holder who authorizes use under this License of the Program or a work on which the Program is 
based. The work thus licensed is called the contributor’s “contributor version”.
A contributor’s “essential patent claims” are all patent claims owned or controlled by the contributor, whether already acquired 
or hereafter acquired, that would be infringed by some manner, permitted by this License, of making, using, or selling its 
contributor version, but do not include claims that would be infringed only as a consequence of further modification of the 
contributor version. For purposes of this definition, “control” includes the right to grant patent sublicenses in a manner 
consistent with the requirements of this License.
Each contributor grants you a non-exclusive, worldwide, royalty-free patent license under the contributor’s essential patent 
claims, to make, use, sell, offer for sale, import and otherwise run, modify and propagate the contents of its contributor version.
In the following three paragraphs, a “patent license” is any express agreement or commitment, however denominated, not 
to enforce a patent (such as an express permission to practice a patent or covenant not to sue for patent infringement). To 
“grant” such a patent license to a party means to make such an agreement or commitment not to enforce a patent against the 
party.
If you convey a covered work, knowingly relying on a patent license, and the Corresponding Source of the work is not 
available for anyone to copy, free of charge and under the terms of this License, through a publicly available network server or 
other readily accessible means, then you must either (1) cause the Corresponding Source to be so available, or (2) arrange 
to deprive yourself of the benefit of the patent license for this particular work, or (3) arrange, in a manner consistent with the 
requirements of this License, to extend the patent license to downstream recipients. “Knowingly relying” means you have 
actual knowledge that, but for the patent license, your conveying the covered work in a country, or your recipient’s use of the 
covered work in a country, would infringe one or more identifiable patents in that country that you have reason to believe are 
valid.
If, pursuant to or in connection with a single transaction or arrangement, you convey, or propagate by procuring conveyance 
of, a covered work, and grant a patent license to some of the parties receiving the covered work authorizing them to use, 
propagate, modify or convey a specific copy of the covered work, then the patent license you grant is automatically extended 
to all recipients of the covered work and works based on it.
A patent license is “discriminatory” if it does not include within the scope of its coverage, prohibits the exercise of, or is 
conditioned on the non-exercise of one or more of the rights that are specifically granted under this License. You may not 
convey a covered work if you are a party to an arrangement with a third party that is in the business of distributing software, 
under which you make payment to the third party based on the extent of your activity of conveying the work, and under which 
the third party grants, to any of the parties who would receive the covered work from you, a discriminatory patent license (a) 
in connection with copies of the covered work conveyed by you (or copies made from those copies), or (b) primarily for and in 
connection with specific products or compilations that contain the covered work, unless you entered into that arrangement, or 
that patent license was granted, prior to 28 March 2007.
Nothing in this License shall be construed as excluding or limiting any implied license or other defenses to infringement that 
may otherwise be available to you under applicable patent law.

��. No Surrender of Others’ Freedom.
If conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this 
License, they do not excuse you from the conditions of this License. If you cannot convey a covered work so as to satisfy 
simultaneously your obligations under this License and any other pertinent obligations, then as a consequence you may not 
convey it at all. For example, if you agree to terms that obligate you to collect a royalty for further conveying from those to 
whom you convey the Program, the only way you could satisfy both those terms and this License would be to refrain entirely 
from conveying the Program.

��. Use with the GNU Affero General Public License.
Notwithstanding any other provision of this License, you have permission to link or combine any covered work with a work 
licensed under version 3 of the GNU Affero General Public License into a single combined work, and to convey the resulting 
work. The terms of this License will continue to apply to the part which is the covered work, but the special requirements of 
the GNU Affero General Public License, section 13, concerning interaction through a network will apply to the combination as 
such.
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��. Revised Versions of this License.
The Free Software Foundation may publish revised and/or new versions of the GNU General Public License from time to time. 
Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns.
Each version is given a distinguishing version number. If the Program specifies that a certain numbered version of the GNU 
General Public License “or any later version” applies to it, you have the option of following the terms and conditions either of 
that numbered version or of any later version published by the Free Software Foundation. If the Program does not specify 
a version number of the GNU General Public License, you may choose any version ever published by the Free Software 
Foundation.
If the Program specifies that a proxy can decide which future versions of the GNU General Public License can be used, that 
proxy’s public statement of acceptance of a version permanently authorizes you to choose that version for the Program.
Later license versions may give you additional or different permissions. However, no additional obligations are imposed on any 
author or copyright holder as a result of your choosing to follow a later version.

��. Disclaimer of Warranty.
THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN 
OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM 
“AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE 
RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE 
DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

��. Limitation of Liability.
IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT 
HOLDER, OR ANY OTHER PARTY WHO MODIFIES AND/OR CONVEYS THE PROGRAM AS PERMITTED ABOVE, BE 
LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES 
ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA 
OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF 
THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

��. Interpretation of Sections 15 and 16.
If the disclaimer of warranty and limitation of liability provided above cannot be given local legal effect according to their terms, 
reviewing courts shall apply local law that most closely approximates an absolute waiver of all civil liability in connection with 
the Program, unless a warranty or assumption of liability accompanies a copy of the Program in return for a fee.

END OF TERMS AND CONDITIONS
How to Apply These Terms to Your New Programs
If you develop a new program, and you want it to be of the greatest possible use to the public, the best way to achieve this is to 
make it free software which everyone can redistribute and change under these terms.
To do so, attach the following notices to the program. It is safest to attach them to the start of each source file to most effectively 
state the exclusion of warranty; and each file should have at least the “copyright” line and a pointer to where the full notice is found.

<one line to give the program’s name and a brief idea of what it does.> Copyright (C) <year> <name of author>
This program is free software: you can redistribute it and/or modify it under the terms of the GNU General Public License as 
published by the Free Software Foundation, either version 3 of the License, or (at your option) any later version.
This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the implied 
warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU General Public License for 
more details.
You should have received a copy of the GNU General Public License along with this program. If not, see <http://www.gnu.
org/licenses/>.

Also add information on how to contact you by electronic and paper mail.
If the program does terminal interaction, make it output a short notice like this when it starts in an interactive mode:

<program> Copyright (C) <year> <name of author> This program comes with ABSOLUTELY NO WARRANTY; for details type 
`show w’. This is free software, and you are welcome to redistribute it under certain conditions; type `show c’ for details.

The hypothetical commands `show w’ and `show c’ should show the appropriate parts of the General Public License. Of course, 
your program’s commands might be different; for a GUI interface, you would use an “about box”.
You should also get your employer (if you work as a programmer) or school, if any, to sign a “copyright disclaimer” for the program, 
if necessary.
For more information on this, and how to apply and follow the GNU GPL, see <http://www.gnu.org/licenses/>.
The GNU General Public License does not permit incorporating your program into proprietary programs. If your program is a 
subroutine library, you may consider it more useful to permit linking proprietary applications with the library. If this is what you want 
to do, use the GNU Lesser General Public License instead of this License. But first, please read <http://www.gnu.org/philosophy/
why-not-lgpl.html>.

¦
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GNU Lesser General Public License (LGPL)
Version �, �� June �00�
 Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>
 Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

Preamble

The GNU General Public License is a free, copyleft license for software and other kinds of works.

The licenses for most software and other practical works are designed to take away your freedom to share and change the 
works. By contrast, the GNU General Public License is intended to guarantee your freedom to share and change all versions 
of a program--to make sure it remains free software for all its users. We, the Free Software Foundation, use the GNU General 
Public License for most of our software; it applies also to any other work released this way by its authors. You can apply it to your 
programs, too.
When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to make sure 
that you have the freedom to distribute copies of free software (and charge for them if you wish), that you receive source code or 
can get it if you want it, that you can change the software or use pieces of it in new free programs, and that you know you can do 
these things.
To protect your rights, we need to prevent others from denying you these rights or asking you to surrender the rights. Therefore, 
you have certain responsibilities if you distribute copies of the software, or if you modify it: responsibilities to respect the freedom of 
others.
For example, if you distribute copies of such a program, whether gratis or for a fee, you must pass on to the recipients the same
freedoms that you received. You must make sure that they, too, receive or can get the source code. And you must show them 
these terms so they know their rights.
Developers that use the GNU GPL protect your rights with two steps: (1) assert copyright on the software, and (2) offer you this 
License giving you legal permission to copy, distribute and/or modify it.
For the developers’ and authors’ protection, the GPL clearly explains that there is no warranty for this free software. For both users’ 
and authors’ sake, the GPL requires that modified versions be marked as changed, so that their problems will not be attributed 
erroneously to authors of previous versions.
Some devices are designed to deny users access to install or run modified versions of the software inside them, although the 
manufacturer can do so. This is fundamentally incompatible with the aim of protecting users’ freedom to change the software. 
The systematic pattern of such abuse occurs in the area of products for individuals to use, which is precisely where it is most 
unacceptable. Therefore, we have designed this version of the GPL to prohibit the practice for those products. If such problems 
arise substantially in other domains, we stand ready to extend this provision to those domains in future versions of the GPL, as 
needed to protect the freedom of users.
Finally, every program is threatened constantly by software patents. States should not allow patents to restrict development and 
use of software on general-purpose computers, but in those that do, we wish to avoid the special danger that patents applied to 
a free program could make it effectively proprietary. To prevent this, the GPL assures that patents cannot be used to render the 
program non-free.
The precise terms and conditions for copying, distribution and modification follow.

TERMS AND CONDITIONS
0.  Definitions.

“This License” refers to version 3 of the GNU General Public License.
“Copyright” also means copyright-like laws that apply to other kinds of works, such as semiconductor masks.
“The Program” refers to any copyrightable work licensed under this License. Each licensee is addressed as “you”. “Licensees” 
and “recipients” may be individuals or organizations.
To “modify” a work means to copy from or adapt all or part of the work in a fashion requiring copyright permission, other than 
the making of an exact copy. The resulting work is called a “modified version” of the earlier work or a work “based on” the 
earlier work.
A “covered work” means either the unmodified Program or a work based on the Program.
To “propagate” a work means to do anything with it that, without permission, would make you directly or secondarily liable 
for infringement under applicable copyright law, except executing it on a computer or modifying a private copy. Propagation 
includes copying, distribution (with or without modification), making available to the public, and in some countries other 
activities as well.
To “convey” a work means any kind of propagation that enables other parties to make or receive copies. Mere interaction with 
a user through a computer network, with no transfer of a copy, is not conveying.
An interactive user interface displays “Appropriate Legal Notices” to the extent that it includes a convenient and prominently 
visible feature that (1) displays an appropriate copyright notice, and (2) tells the user that there is no warranty for the work 
(except to the extent that warranties are provided), that licensees may convey the work under this License, and how to view a 
copy of this License. If the interface presents a list of user commands or options, such as a menu, a prominent item in the list 
meets this criterion.

¦
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�. Source Code.
The “source code” for a work means the preferred form of the work for making modifications to it. “Object code” means any 
non-source
form of a work.
A “Standard Interface” means an interface that either is an official standard defined by a recognized standards body, or, in the 
case of interfaces specified for a particular programming language, one that is widely used among developers working in that 
language.
The “System Libraries” of an executable work include anything, other than the work as a whole, that (a) is included in the 
normal form of packaging a Major Component, but which is not part of that Major Component, and (b) serves only to enable 
use of the work with that Major Component, or to implement a Standard Interface for which an implementation is available to 
the public in source code form. A “Major Component”, in this context, means a major essential component (kernel, window 
system, and so on) of the specific operating system (if any) on which the executable work runs, or a compiler used to produce 
the work, or an object code interpreter used to run it.
The “Corresponding Source” for a work in object code form means all the source code needed to generate, install, and (for an 
executable work) run the object code and to modify the work, including scripts to control those activities. However, it does not 
include the work’s System Libraries, or general-purpose tools or generally available free programs which are used unmodified 
in performing those activities but which are not part of the work. For example, Corresponding Source includes interface 
definition files associated with source files for the work, and the source code for shared libraries and dynamically linked 
subprograms that the work is specifically designed to require, such as by intimate data communication or control flow between 
those subprograms and other parts of the work.
The Corresponding Source need not include anything that users can regenerate automatically from other parts of the 
Corresponding Source.
The Corresponding Source for a work in source code form is that same work.

�. Basic Permissions.
All rights granted under this License are granted for the term of copyright on the Program, and are irrevocable provided the 
stated conditions are met. This License explicitly affirms your unlimited permission to run the unmodified Program. The output 
from running a covered work is covered by this License only if the output, given its content, constitutes a covered work. 
This License acknowledges your rights of fair use or other equivalent, as provided by copyright law. You may make, run and 
propagate covered works that you do not convey, without conditions so long as your license otherwise remains in force. You 
may convey covered works to others for the sole purpose of having them make modifications exclusively for you, or provide 
you with facilities for running those works, provided that you comply with the terms of this License in conveying all material 
for which you do not control copyright. Those thus making or running the covered works for you must do so exclusively on 
your behalf, under your direction and control, on terms that prohibit them from making any copies of your copyrighted material 
outside their relationship with you.
Conveying under any other circumstances is permitted solely under the conditions stated below. Sublicensing is not allowed; 
section 10 makes it unnecessary.

�. Protecting Users’ Legal Rights From Anti-Circumvention Law.
No covered work shall be deemed part of an effective technological measure under any applicable law fulfilling obligations 
under article 11 of the WIPO copyright treaty adopted on 20 December 1996, or similar laws prohibiting or restricting 
circumvention of such measures.
When you convey a covered work, you waive any legal power to forbid circumvention of technological measures to the extent 
such circumvention is effected by exercising rights under this License with respect to the covered work, and you disclaim any 
intention to limit operation or modification of the work as a means of enforcing, against the work’s users, your or third parties’ 
legal rights to forbid circumvention of technological measures.

�. Conveying Verbatim Copies.
You may convey verbatim copies of the Program’s source code as you receive it, in any medium, provided that you 
conspicuously and appropriately publish on each copy an appropriate copyright notice; keep intact all notices stating that this 
License and any non-permissive terms added in accord with section 7 apply to the code; keep intact all notices of the absence 
of any warranty; and give all recipients a copy of this License along with the Program.
You may charge any price or no price for each copy that you convey, and you may offer support or warranty protection for a 
fee.

�. Conveying Modified Source Versions.
You may convey a work based on the Program, or the modifications to produce it from the Program, in the form of source code 
under the terms of section 4, provided that you also meet all of these conditions:

a) The work must carry prominent notices stating that you modified it, and giving a relevant date.
b) The work must carry prominent notices stating that it is released under this License and any conditions added under 
section 7. This requirement modifies the requirement in section 4 to “keep intact all notices”.
c) You must license the entire work, as a whole, under this License to anyone who comes into possession of a copy. This 
License will therefore apply, along with any applicable section 7 additional terms, to the whole of the work, and all its 
parts, regardless of how they are packaged. This License gives no permission to license the work in any other way, but it 
does not invalidate such permission if you have separately received it.
d) If the work has interactive user interfaces, each must display Appropriate Legal Notices; however, if the Program has 
interactive interfaces that do not display Appropriate Legal Notices, your work need not make them do so.

�
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A compilation of a covered work with other separate and independent works, which are not by their nature extensions of 
the covered work, and which are not combined with it such as to form a larger program, in or on a volume of a storage or 
distribution medium, is called an “aggregate” if the compilation and its resulting copyright are not used to limit the access or 
legal rights of the compilation’s users beyond what the individual works permit. Inclusion of a covered work in an aggregate 
does not cause this License to apply to the other parts of the aggregate.

�. Conveying Non-Source Forms.
You may convey a covered work in object code form under the terms of sections 4 and 5, provided that you also convey the 
machine-readable Corresponding Source under the terms of this License, in one of these ways:

a) Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied 
by the Corresponding Source fixed on a durable physical medium customarily used for software interchange.
b) Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied 
by a written offer, valid for at least three years and valid for as long as you offer spare parts or customer support for that 
product model, to give anyone who possesses the object code either (1) a copy of the Corresponding Source for all the 
software in the product that is covered by this License, on a durable physical medium customarily used for software 
interchange, for a price no more than your reasonable cost of physically performing this conveying of source, or (2) 
access to copy the Corresponding Source from a network server at no charge.
c) Convey individual copies of the object code with a copy of the written offer to provide the Corresponding Source. This 
alternative is allowed only occasionally and noncommercially, and only if you received the object code with such an offer, 
in accord with subsection 6b.
d) Convey the object code by offering access from a designated place (gratis or for a charge), and offer equivalent 
access to the Corresponding Source in the same way through the same place at no further charge. You need not require 
recipients to copy the Corresponding Source along with the object code. If the place to copy the object code is a network 
server, the Corresponding Source may be on a different server (operated by you or a third party) that supports equivalent 
copying facilities, provided you maintain clear directions next to the object code saying where to find the Corresponding 
Source. Regardless of what server hosts the Corresponding Source, you remain obligated to ensure that it is available for 
as long as needed to satisfy these requirements.
e) Convey the object code using peer-to-peer transmission, provided you inform other peers where the object code and 
Corresponding Source of the work are being offered to the general public at no charge under subsection 6d. A separable 
portion of the object code, whose source code is excluded from the Corresponding Source as a System Library, need not 
be included in conveying the object code work.

A “User Product” is either (1) a “consumer product”, which means any tangible personal property which is normally used for 
personal, family, or household purposes, or (2) anything designed or sold for incorporation into a dwelling. In determining 
whether a product is a consumer product, doubtful cases shall be resolved in favor of coverage. For a particular product 
received by a particular user, “normally used” refers to a typical or common use of that class of product, regardless of the 
status of the particular user or of the way in which the particular user actually uses, or expects or is expected to use, the 
product. A product is a consumer product regardless of whether the product has substantial commercial, industrial or non-
consumer uses, unless such uses represent the only significant mode of use of the product.
“Installation Information” for a User Product means any methods, procedures, authorization keys, or other information required 
to install and execute modified versions of a covered work in that User Product from a modified version of its Corresponding 
Source. The information must suffice to ensure that the continued functioning of the modified object code is in no case 
prevented or interfered with solely because modification has been made.
If you convey an object code work under this section in, or with, or specifically for use in, a User Product, and the conveying 
occurs as part of a transaction in which the right of possession and use of the User Product is transferred to the recipient in 
perpetuity or for a fixed term (regardless of how the transaction is characterized), the Corresponding Source conveyed under 
this section must be accompanied by the Installation Information. But this requirement does not apply if neither you nor any 
third party retains the ability to install modified object code on the User Product (for example, the work has been installed in 
ROM).
The requirement to provide Installation Information does not include a requirement to continue to provide support service, 
warranty, or updates for a work that has been modified or installed by the recipient, or for the User Product in which it has 
been modified or installed. Access to a network may be denied when the modification itself materially and adversely affects the 
operation of the network or violates the rules and protocols for communication across the network.
Corresponding Source conveyed, and Installation Information provided, in accord with this section must be in a format that is 
publicly documented (and with an implementation available to the public in source code form), and must require no special 
password or key for unpacking, reading or copying.

�. Additional Terms.
“Additional permissions” are terms that supplement the terms of this License by making exceptions from one or more of its 
conditions. Additional permissions that are applicable to the entire Program shall be treated as though they were included in 
this License, to the extent that they are valid under applicable law. If additional permissions apply only to part of the Program, 
that part may be used separately under those permissions, but the entire Program remains governed by this License without 
regard to the additional permissions.
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When you convey a copy of a covered work, you may at your option remove any additional permissions from that copy, or 
from any part of it. (Additional permissions may be written to require their own removal in certain cases when you modify the 
work.) You may place additional permissions on material, added by you to a covered work, for which you have or can give 
appropriate copyright permission.
Notwithstanding any other provision of this License, for material you add to a covered work, you may (if authorized by the 
copyright holders of that material) supplement the terms of this License with terms:

a) Disclaiming warranty or limiting liability differently from the terms of sections 15 and 16 of this License; or
b) Requiring preservation of specified reasonable legal notices or author attributions in that material or in the Appropriate 
Legal Notices displayed by works containing it; or
c) Prohibiting misrepresentation of the origin of that material, or requiring that modified versions of such material be 
marked in reasonable ways as different from the original version; or
d) Limiting the use for publicity purposes of names of licensors or authors of the material; or
e) Declining to grant rights under trademark law for use of some trade names, trademarks, or service marks; or
f) Requiring indemnification of licensors and authors of that material by anyone who conveys the material (or modified 
versions of it) with contractual assumptions of liability to the recipient, for any liability that these contractual assumptions 
directly impose on those licensors and authors.

All other non-permissive additional terms are considered “further restrictions” within the meaning of section 10. If the Program 
as you received it, or any part of it, contains a notice stating that it is governed by this License along with a term that is a 
further restriction, you may remove that term. If a license document contains a further restriction but permits relicensing or 
conveying under this License, you may add to a covered work material governed by the terms of that license document, 
provided that the further restriction does not survive such relicensing or conveying.
If you add terms to a covered work in accord with this section, you must place, in the relevant source files, a statement of the 
additional terms that apply to those files, or a notice indicating where to find the applicable terms.
Additional terms, permissive or non-permissive, may be stated in the form of a separately written license, or stated as 
exceptions; the above requirements apply either way. 

�. Termination.
You may not propagate or modify a covered work except as expressly provided under this License. Any attempt otherwise to 
propagate or modify it is void, and will automatically terminate your rights under this License (including any patent licenses 
granted under the third paragraph of section 11).
However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated (a) 
provisionally, unless and until the copyright holder explicitly and finally terminates your license, and (b) permanently, if the 
copyright holder fails to notify you of the violation by some reasonable means prior to 60 days after the cessation.
Moreover, your license from a particular copyright holder is reinstated permanently if the copyright holder notifies you of the 
violation by some reasonable means, this is the first time you have received notice of violation of this License (for any work) 
from that copyright holder, and you cure the violation prior to 30 days after your receipt of the notice.
Termination of your rights under this section does not terminate the licenses of parties who have received copies or rights from 
you under this License. If your rights have been terminated and not permanently reinstated, you do not qualify to receive new 
licenses for the same material under section 10.

�. Acceptance Not Required for Having Copies.
You are not required to accept this License in order to receive or run a copy of the Program. Ancillary propagation of a covered 
work occurring solely as a consequence of using peer-to-peer transmission to receive a copy likewise does not require 
acceptance. However, nothing other than this License grants you permission to propagate or modify any covered work. These 
actions infringe copyright if you do not accept this License. Therefore, by modifying or propagating a covered work, you 
indicate your acceptance of this License to do so.

�0. Automatic Licensing of Downstream Recipients.
Each time you convey a covered work, the recipient automatically receives a license from the original licensors, to run, modify 
and propagate that work, subject to this License. You are not responsible for enforcing compliance by third parties with this 
License.
An “entity transaction” is a transaction transferring control of an organization, or substantially all assets of one, or subdividing 
an organization, or merging organizations. If propagation of a covered work results from an entity transaction, each party 
to that transaction who receives a copy of the work also receives whatever licenses to the work the party’s predecessor in 
interest had or could give under the previous paragraph, plus a right to possession of the Corresponding Source of the work 
from the predecessor in interest, if the predecessor has it or can get it with reasonable efforts.
You may not impose any further restrictions on the exercise of the rights granted or affirmed under this License. For example, 
you may not impose a license fee, royalty, or other charge for exercise of rights granted under this License, and you may not 
initiate litigation (including a cross-claim or counterclaim in a lawsuit) alleging that any patent claim is infringed by making, 
using, selling, offering for sale, or importing the Program or any portion of it.

�
�

�

�
�
�
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��. Patents.
A “contributor” is a copyright holder who authorizes use under this License of the Program or a work on which the Program is 
based. The work thus licensed is called the contributor’s “contributor version”.
A contributor’s “essential patent claims” are all patent claims owned or controlled by the contributor, whether already acquired 
or hereafter acquired, that would be infringed by some manner, permitted by this License, of making, using, or selling its 
contributor version, but do not include claims that would be infringed only as a consequence of further modification of the 
contributor version. For purposes of this definition, “control” includes the right to grant patent sublicenses in a manner 
consistent with the requirements of this License.
Each contributor grants you a non-exclusive, worldwide, royalty-free patent license under the contributor’s essential patent 
claims, to make, use, sell, offer for sale, import and otherwise run, modify and propagate the contents of its contributor version.
In the following three paragraphs, a “patent license” is any express agreement or commitment, however denominated, not 
to enforce a patent (such as an express permission to practice a patent or covenant not to sue for patent infringement). To 
“grant” such a patent license to a party means to make such an agreement or commitment not to enforce a patent against the 
party.
If you convey a covered work, knowingly relying on a patent license, and the Corresponding Source of the work is not 
available for anyone to copy, free of charge and under the terms of this License, through a publicly available network server or 
other readily accessible means, then you must either (1) cause the Corresponding Source to be so available, or (2) arrange 
to deprive yourself of the benefit of the patent license for this particular work, or (3) arrange, in a manner consistent with the 
requirements of this License, to extend the patent license to downstream recipients. “Knowingly relying” means you have 
actual knowledge that, but for the patent license, your conveying the covered work in a country, or your recipient’s use of the 
covered work in a country, would infringe one or more identifiable patents in that country that you have reason to believe are 
valid.
If, pursuant to or in connection with a single transaction or arrangement, you convey, or propagate by procuring conveyance 
of, a covered work, and grant a patent license to some of the parties receiving the covered work authorizing them to use, 
propagate, modify or convey a specific copy of the covered work, then the patent license you grant is automatically extended 
to all recipients of the covered work and works based on it.
A patent license is “discriminatory” if it does not include within the scope of its coverage, prohibits the exercise of, or is 
conditioned on the non-exercise of one or more of the rights that are specifically granted under this License. You may not 
convey a covered work if you are a party to an arrangement with a third party that is in the business of distributing software, 
under which you make payment to the third party based on the extent of your activity of conveying the work, and under which 
the third party grants, to any of the parties who would receive the covered work from you, a discriminatory patent license (a) 
in connection with copies of the covered work conveyed by you (or copies made from those copies), or (b) primarily for and in 
connection with specific products or compilations that contain the covered work, unless you entered into that arrangement, or 
that patent license was granted, prior to 28 March 2007.
Nothing in this License shall be construed as excluding or limiting any implied license or other defenses to infringement that 
may otherwise be available to you under applicable patent law.

��. No Surrender of Others’ Freedom.
If conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this 
License, they do not excuse you from the conditions of this License. If you cannot convey a covered work so as to satisfy 
simultaneously your obligations under this License and any other pertinent obligations, then as a consequence you may not 
convey it at all. For example, if you agree to terms that obligate you to collect a royalty for further conveying from those to 
whom you convey the Program, the only way you could satisfy both those terms and this License would be to refrain entirely 
from conveying the Program.

��. Use with the GNU Affero General Public License.
Notwithstanding any other provision of this License, you have permission to link or combine any covered work with a work 
licensed under version 3 of the GNU Affero General Public License into a single combined work, and to convey the resulting 
work. The terms of this License will continue to apply to the part which is the covered work, but the special requirements of 
the GNU Affero General Public License, section 13, concerning interaction through a network will apply to the combination as 
such.

��. Revised Versions of this License.
The Free Software Foundation may publish revised and/or new versions of the GNU General Public License from time to time. 
Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns.
Each version is given a distinguishing version number. If the Program specifies that a certain numbered version of the GNU 
General Public License “or any later version” applies to it, you have the option of following the terms and conditions either of 
that numbered version or of any later version published by the Free Software Foundation. If the Program does not specify 
a version number of the GNU General Public License, you may choose any version ever published by the Free Software 
Foundation.
If the Program specifies that a proxy can decide which future versions of the GNU General Public License can be used, that 
proxy’s public statement of acceptance of a version permanently authorizes you to choose that version for the Program.
Later license versions may give you additional or different permissions. However, no additional obligations are imposed on any 
author or copyright holder as a result of your choosing to follow a later version.
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��. Disclaimer of Warranty.
THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN 
OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM 
“AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE 
RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE 
DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

��. Limitation of Liability.
IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT 
HOLDER, OR ANY OTHER PARTY WHO MODIFIES AND/OR CONVEYS THE PROGRAM AS PERMITTED ABOVE, BE 
LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES 
ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA 
OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF 
THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

��. Interpretation of Sections 15 and 16.
If the disclaimer of warranty and limitation of liability provided above cannot be given local legal effect according to their terms, 
reviewing courts shall apply local law that most closely approximates an absolute waiver of all civil liability in connection with 
the Program, unless a warranty or assumption of liability accompanies a copy of the Program in return for a fee.

END OF TERMS AND CONDITIONS
How to Apply These Terms to Your New Programs
If you develop a new program, and you want it to be of the greatest possible use to the public, the best way to achieve this is to 
make it free software which everyone can redistribute and change under these terms.
To do so, attach the following notices to the program. It is safest to attach them to the start of each source file to most effectively 
state the exclusion of warranty; and each file should have at least the “copyright” line and a pointer to where the full notice is found.

<one line to give the program’s name and a brief idea of what it does.> Copyright (C) <year> <name of author>
This program is free software: you can redistribute it and/or modify it under the terms of the GNU General Public License as 
published by the Free Software Foundation, either version 3 of the License, or (at your option) any later version.
This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the implied 
warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU General Public License for 
more details.
You should have received a copy of the GNU General Public License along with this program. If not, see <http://www.gnu.
org/licenses/>.

Also add information on how to contact you by electronic and paper mail.
If the program does terminal interaction, make it output a short notice like this when it starts in an interactive mode:

<program> Copyright (C) <year> <name of author> This program comes with ABSOLUTELY NO WARRANTY; for details type 
`show w’. This is free software, and you are welcome to redistribute it under certain conditions; type `show c’ for details.

The hypothetical commands `show w’ and `show c’ should show the appropriate parts of the General Public License. Of course, 
your program’s commands might be different; for a GUI interface, you would use an “about box”.
You should also get your employer (if you work as a programmer) or school, if any, to sign a “copyright disclaimer” for the program, 
if necessary.
For more information on this, and how to apply and follow the GNU GPL, see <http://www.gnu.org/licenses/>.
The GNU General Public License does not permit incorporating your program into proprietary programs. If your program is a 
subroutine library, you may consider it more useful to permit linking proprietary applications with the library. If this is what you want 
to do, use the GNU Lesser General Public License instead of this License. But first, please read <http://www.gnu.org/philosophy/
why-not-lgpl.html>.

¦
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LICENSE ISSUES
The OpenSSL toolkit stays under a dual license, i.e. both the conditions of the OpenSSL License and the original SSLeay license 
apply to the toolkit. See below for the actual license texts. Actually both licenses are BSD-style Open Source licenses. In case of 
any license issues related to OpenSSL please contact openssl-core@openssl.org.
OpenSSL License
Copyright (c) 1998-2007 The OpenSSL Project. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions 
are met:
�. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
�. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in 

the documentation and/or other materials provided with the distribution.
�. All advertising materials mentioning features or use of this software must display the following acknowledgment: “This product 

includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)”
�. The names “OpenSSL Toolkit” and “OpenSSL Project” must not be used to endorse or promote products derived from this 

software without prior written permission. For written permission, please contact openssl-core@openssl.org.
�. Products derived from this software may not be called “OpenSSL nor may “OpenSSL” appear in their names without prior 

written permission of the OpenSSL Project.
�. Redistributions of any form whatsoever must retain the following acknowledgment: “This product includes software developed 

by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)”
THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT “AS IS’’ AND ANY EXPRESSED OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, 
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product includes software written by 
Tim Hudson (tjh@cryptsoft.com).

Original SSLeay License
Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved.
This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The implementation was written so as to 
conform with Netscapes SSL.
This library is free for commercial and non-commercial use as long as the following conditions are aheared to. The following 
conditions apply to all code found in this distribution, be it the RC4, RSA, lhash, DES, etc., code; not just the SSL code. The SSL 
documentation included with this distribution is covered by the same copyright terms except that the holder is Tim Hudson (tjh@
cryptsoft.com).
Copyright remains Eric Young’s, and as such any Copyright notices in the code are not to be removed. If this package is used in 
a product, Eric Young should be given attribution as the author of the parts of the library used. This can be in the form of a textual 
message at program startup or in documentation (online or textual) provided with the package.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions 
are met:
�. Redistributions of source code must retain the copyright notice, this list of conditions and the following disclaimer.
�. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in 

the documentation and/or other materials provided with the distribution.
�. All advertising materials mentioning features or use of this software must display the following acknowledgement: “This 

product includes cryptographic software written by Eric Young (eay@cryptsoft.com)” The word ‘cryptographic’ can be left out if 
the rouines from the library being used are not cryptographic related :-).

�. If you include any Windows specific code (or a derivative thereof) from the apps directory (application code) you must include 
an acknowledgement: “This product includes software written by Tim Hudson (tjh@cryptsoft.com)”

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG “AS IS’’ AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED 
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, 
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
The licence and distribution terms for any publically available version or derivative of this code cannot be changed. i.e. this code 
cannot simply be copied and put under another distribution licence [including the GNU Public Licence.]

¦
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